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Preface

This guide describes how to customize and distribute Netscape 7.0. It includes 
information on how to 

• Find information on setting up and running an ISP.

• Use the Netscape Client Customization Kit (CCK) tool to create customized 
Netscape 7.0 installers for Windows, Linux, and Macintosh.

• Make additional customizations by manipulating the installation files.

• Prepare the final, customized installation files for delivery on CD-ROM or by 
network download.

• Provide your users with basic account setup information.

Before using the CCK tool or this guide, be sure to check the latest Netscape 7.0 
Client Customization Kit Release Notes and sign up for the Browser Distribution 
Program. For details on where to find these and other important sources of 
information, see Where to Go for Related Information (page 15).

This preface contains these sections:

Who Should Read This Guide
About the CCK Tool
If You've Used a Previous Version of CCK
How to Use This Guide
Where to Go for Related Information
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Who Should Read This Guide
This guide is intended for organizations that need a simple solution for 
customizing Netscape and distributing it to their end users. If you are an ISP or 
distributor, for example, you can use the Client Customization Kit (CCK) to create 
and distribute customized versions of Netscape 7.0. 

This guide describes how to use the CCK tool to create a customized Netscape 7.0 
installer, prepare it for cross-platform distribution via CDs and/or network 
installers, and ensure that your customers can easily connect to their Internet 
accounts using a modem and phone line.

About the CCK Tool
The CCK tool allows you to customize basic Netscape preferences and defaults and 
add your own branding elements to the Navigator browser, the CD autorun 
screen, and the Netscape installer. These customizations can help promote your 
business, simplify account set up for new users, drive traffic to your site, and 
reduce service and support costs by providing links to online resources.

The CCK Tool creates Netscape installers for Windows 95/98, Windows 2000, 
Windows NT, and Linux operating systems. You can also produce a Macintosh 
version by completing additional manual steps (documented in this guide) after 
you produce a Windows version.

The CCK tool lets you create these customizations in just a few minutes:

• Display your company name in the browser window’s title bar, the CD 
autorun screen, and the Netscape program folder in the Windows Start menu.

• Set the browser's default home page to your own home page.

• Include entries in Bookmarks, Sidebar, and the Personal Toolbar folder.

• Specify Mail and News server settings.

• Create a Netscape installer that installs only the components you want your 
users to have.

The CCK tool also helps you create these customizations, which require some 
preparation before you run the tool:

• Browser customizations:

❍ Create a custom animated logo
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❍ Add a Help menu item and corresponding URL

❍ Customize the read-me file

• CD autorun screen customizations:

❍ Create custom background image

❍ Customize on-screen text

❍ Customize the installation document 

• Installer customizations

❍ Component selection

❍ Integration of additional installers

After you have run the tool and tested its customizations, you can perform a wide 
range of advanced manual customizations by modifying the installation files. 
Manual customizations include:

• Advanced customizations for the CD autorun screen

• Advanced Netscape customizations (such as disabling Netscape activation or 
presetting proxy preferences)

After you have tested your manual customizations, you may need to manipulate 
the installation files further to create Macintosh installers. In addition, you’ll need 
to prepare to distribute your installers (by means of CDs or network-downloadable 
installers) and plan for post-distribution support, such as account setup and 
troubleshooting.

If You've Used a Previous Version of CCK
If you've used a previous version of CCK for Communicator 4.x, the main 
difference with this version is that instead of using separate tools to customize the 
browser, you now use just one tool—the CCK tool—to make the most popular 
browser customizations. If you used Netscape 6.x CCK, the main change with 
Netscape 7.0 is additional support for Linux.
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Using Existing Customized Files
In most cases you can use your existing customized files without having to make 
any changes to them. Refer to Table 1 for information on using existing customized 
files with the CCK tool.

Table 1 Using Existing Customized CCK 4.x and 6.x Files

To Use This File Do This

Netscape.cfg (4.x only) Not supported in 6.x or 7.0. For information on 
preferences formerly included in this file, see Chapter 
12, “Advanced Netscape Customizations” (page 121).

rshell.ini file (specifies 
CD autorun screens)

No changes are necessary.

For information on incorporating this file into your 
Netscape installer, see Chapter 11, “Manually 
Customizing the CD Autorun Screen” (page 101).

Any custom files you've 
created for the CD autorun 
screens, such as custom .bmp 
images (for background 
images and buttons on the 
Autorun screens)

No changes necessary.

For information on incorporating these files into your 
Netscape installer, seeChapter 11, “Manually 
Customizing the CD Autorun Screen” (page 101).

Small and large animation files 
(.BMP format) for Navigator 
animated logo

Convert the small and large .BMP files to .GIF format 
animation files.

For information on incorporating these files into your 
Netscape 7.0 installer, see Chapter 5, “Preparing to 
Customize the Netscape Browser” (page 67).

bookmark.htm file (4.x) 

bookmark.html file (6.x) 

With CCK 7.0 you no longer customize the 
bookmarks.html file, but instead enter bookmarks 
information directly in the CCK Tool.

.NCI files (for offline account 
setup)

.NCI files are not supported in Netscape 6.x or 
Netscape 7.0.

readme.txt file No changes are necessary.

For information on incorporating this file into your 
Netscape 7.0 installer, see Chapter 5, “Preparing to 
Customize the Netscape Browser” (page 67).

NetHelp files (4.x only) NetHelp is no longer supported in Netscape 6.x or 
Netscpe 7.0.

Pab.na2 (address book) No changes are necessary.



How to Use This Guide

Preface 13

How to Use This Guide
For the latest online version of this guide, which is updated periodically, see the 
following:

• HTML version:
http://home.netscape.com/eng/mozilla/ns7/CCKDocs/guide.html

• PDF version (easiest for printing): 
http://home.netscape.com/eng/mozilla/ns7/CCKDocs/pdf/

Start by reading these two chapters:

• Chapter 1, “Getting Started” (page 17), describes the system requirements for 
running the CCK tool and basic information about using it.

• Chapter 2, “Customizing Netscape in Ten Minutes” (page 39), describes how 
to make the simple customizations listed above and create a Windows installer. 
Even if you want to make some of the other complex customizations described 
in the rest of this document, this chapter can help you get acquainted with the 
CCK tool quickly.

If you are making only the simplest customizations described in Chapter 2, you can 
skip to Chapter 12 or Chapter 13 (see below).

If you need more information about any CCK tool screen or if you wish to use the 
CCK tool to make additional customizations that require some file preparation, 
read the following chapters:

• Chapter 3, “Using the Configuration Workspace for Customized Files” 
(page 55), describes the contents of the configuration directory, the files you 
can customize, and where to store them for easy access when you run the CCK 
tool.

• Chapter 4, “Preparing Operating System, Language, and Installer Information” 
(page 61), describes how to choose a platform and specify other basic 
information about your installer.

Setup.bmp (installer splash 
screen bitmap file -- 4.x only)

This file is no longer supported. 

Table 1 Using Existing Customized CCK 4.x and 6.x Files

To Use This File Do This
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• Chapter 5, “Preparing to Customize the Netscape Browser” (page 67), 
describes the information and files you need to prepare for customizing 
different aspects of Navigator, the Netscape browser. 

• Chapter 6, “Preparing to Customize Netscape Mail and News” (page 75), 
describes the information you need to have on hand if you want customize 
your default domain and server settings for Netscape Mail and Newsgroups.

• Chapter 8, “Preparing to Customize the CD Autorun Screen” (page 83), 
describes the information and files you need to prepare in order to customize 
the CD autorun screen with the CCK tool.

• Chapter 9, “Preparing to Create the Installer” (page 91), describes the Netscape 
components you can choose to include in your installer and the requirements 
for additional installers you may wish to create.

• Chapter 10, “Verifying Your CCK Tool Customizations” (page 95), describes 
how to verify the customizations you have made with the CCK tool.

After you have verified all the customization you have made with the CCK tool, 
you can make additional manual customizations if you wish:

• Chapter 11, “Manually Customizing the CD Autorun Screen” (page 101), 
describes the manual customizations you can make, if you wish, to the CD 
autorun screen by manipulating the installation files generated by the CCK 
tool.

• Chapter 12, “Advanced Netscape Customizations” (page 121), provides an 
overview of the preferences architecture and the general procedure for manual 
customization, as well as detailed, step-by-step instructions for some of the 
most common manual customizations.

After you have completed and verified all your manual customizations, follow the 
instructions in these chapters that apply to your situation:

• Chapter 13, “Preparing Macintosh Installers and Program Files” (page 129), 
describes how to create a Macintosh installer from the Windows installation 
files you generated with the CCK tool. 

• Chapter 14, “Distributing Your Installers” (page 135), describes how to prepare 
your customized installation files for CD or online distribution.

Two appendixes provide additional practical information for ISPs:

• Appendix A, “Resources for ISPs” (page 145), provides links to information for 
ISPs
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• Appendix B, “Manual Account Setup” (page 149), summarizes the minimum 
information your customers need to set up their own accounts for your ISP 
business on Windows.

• Appendix C, “Netscape Profile Locations by Platform” (page 157), summarizes 
the location of Netscape profile directories on different platforms.

Where to Go for Related Information
Before using the CCK tool or this guide, be sure to check the latest Netscape 7.0 
Client Customization Kit Release Notes 
(http://home.netscape.com/eng/mozilla/ns7/relnotes/cck.html) and sign 
up for the Browser Distribution Program 
(http://home.netscape.com/bisdev/distribution/index.html). 

For the latest online version of this guide, which is updated periodically, see the 
following:

• HTML version:
http://home.netscape.com/eng/mozilla/ns62/CCKDocs/guide.html

• PDF version (easiest for printing): 
http://home.netscape.com/eng/mozilla/ns7/CCKDocs/pdf/

For information on third-party software and distribution solutions, see:

http:www.netscapetogo.com

For links to information on setting up an ISP, see Appendix A, “Resources for ISPs” 
(page 145).
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Chapter 1

Getting Started

This chapter provides an overview of the customization and distribution process, a 
brief introduction to the kinds of customizations you can make with the Client 
Customization Kit (CCK), and a few simple guidelines for using the CCK Tool.

Before using the CCK tool or this guide, sign up for the Browser Distribution 
Program:

http://home.netscape.com/bisdev/distribution/index.html

This chapter contains these sections:

Why Customize and Distribute Netscape?
Overview of the Customization and Distribution Process
System Requirements
Platform Support
Installing the Client Customization Kit Tool
What Customizations Can I Make?
Which Customizations Can I Make Quickly?
Using the CCK Tool
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Why Customize and Distribute Netscape?
The Netscape browser is the most customizable browser available today. By 
customizing Netscape to match your business requirements, you can drive more 
traffic to your web site, increase revenue, and reduce development and support. 
Combined with the loyal Netscape customer base and strong brand acceptance, the 
ability to tailor Netscape to your needs makes it stand out as a powerful business 
asset compared to other browsers.

Netscape 7.0 can help you

• Increase Revenue. Increase customer loyalty by inserting your branding into 
every component of Netscape 7.0 (browser, Mail, Instant Messenger, and 
more). 

Increase traffic to your site by customizing bookmarks and other links in the 
browser interface. Include your own tabs in the sidebar to give your customers 
even more prominent and persistent access to your revenue-generating content 
and services.

• Decrease Costs. Reduce support costs by integrating online support. By 
customizing Sidebar, the Personal Toolbar and the Help menu, you can drive 
your customers to your online support and away from costly phone calls. In 
addition, Netscape 7.0 has demonstrated superior performance and stability, 
especially for low-bandwidth customers.

• Attract Customers. The Netscape brand can differentiate your product. With 
over 20 million current users and a well respected brand throughout the 
industry, Netscape can make the decisive difference between you and your 
competitors. Netscape’s unusually loyal customer base makes this particularly 
true.

People want the Netscape browser. Internal research repeatedly shows that 
among people who choose their software, more pick Netscape than any other 
browser.

Why Do Users Prefer Netscape 7.0?
While many people are loyal to the Netscape brand, others choose it because of the 
product benefits. Netscape 7.0 lets them do more online and exercise fine-grained 
control over their online experience. It also delivers greatly enhanced performance 
and stability:
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• Efficiency in completing tasks. Netscape 7.0 has been designed with efficiency 
in mind, to reduce the number of steps—and time—it takes to get things done 
on the Web.

Features include integrated Search to help you find what you need in fewer 
steps; Quick Launch to dramatically reduce start-up time; a download dialog 
to prevent you from losing files; Form Manager to complete long web forms in 
just two clicks; Email Address Collection so you will never lose an email 
address again; and integrated Instant Messaging for immediate access to your 
online buddies.

• More choice. Choice is particularly important to people who use the Web 
frequently. They want the power to choose how they work online and what 
their online environment is like.

Netscape let’s you choose which tabs to include in Sidebar (choose among 
hundreds or create your own), set default mail and news server settings, 
(including AOL Mail, Netscape WebMail, as well as other IMAP and POP 
accounts like Yahoo), and even modify the user interface (customize 
bookmarks and the Personal Toolbar or add a Help menu item). 

• Safety with more control. If you are concerned about safety, you want to be 
able to control your environment. Netscape 7.0 delivers more control over the 
privacy and security of your Internet experience than any other browser.

The Cookie Manager lets you review the cookies you have and easily reject all 
cookies, past and future, from web sites you do not trust. The Password 
Manager can conveniently remember your various passwords for different 
sites, and you can set a Master Password to encrypt that information and other 
data so you can safely share your computer with family and co-workers.

To learn more about Netscape 7.0, see 
http://channels.netscape.com/ns/browsers/default.jsp.
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Overview of the Customization and Distribution 
Process

Here’s an overview of the main steps you’ll follow to customize and distribute 
your own version of Netscape 7.0: 

1. Set up your ISP. If you are setting up your ISP business, you must first do the 
necessary business and financial planning; set up your servers, Internet access, 
and other physical infrastructure; and plan for post-distribution customer 
support. For sources of information on these topics, see Appendix A, 
“Resources for ISPs” (page 145). 

2. Register for the Browser Distribution Program (BDP). For details, see 

http://channels.netscape.com/ns/browsers/partners/bdp.jsp

Registration gives you permission to distribute the Netscape browser. See the 
license available at the BDP site for details.

3. Decide which customization strategy you want to pursue. You have three 
choices:

❍ Distribute Netscape 7.0 without making any customizations. If you choose 
this option, you can skip to Step 9 below.

❍ Customize and distribute Netscape 7.0 yourself by following the 
remaining steps in this section.

❍ Use the Netscape to Go program to customize Netscape 7.0 to your 
specifications. If you choose this option, visit 
http://www.netscapetogo.com/ to make your customization 
arrangements and skip to Step 10 below.

4. Use the CCK tool to make the simplest customizations. Follow these steps:

a. Download and install the Client Customization Kit 

b. Review the rest of this chapter and make sure your available hardware and 
software meets the system requirements.

c. Follow the instructions in Chapter 2, “Customizing Netscape in Ten 
Minutes” (page 39) for making the simplest customizations. Even if you 
want to make some of the more complex customizations described in the 
rest of this document, this chapter can help you get acquainted with the 
CCK tool quickly.
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d. Based on the information in this chapter and Chapter 2, determine what 
customizations you want to make and which platforms you want to create 
installers for.

e. If the customizations you want to make are limited to the simple ones 
described in Chapter 2, you can skip to Chapter 12 or Chapter 13 (see 
Step 9 below).

5. Use the CCK Tool to make more advanced customizations. Follow these 
steps:

a. If you need more information about any CCK tool screen or if you wish to 
use the CCK tool to make additional customizations that require some file 
preparation, read the relevant parts of Chapters 3 through 9.

b. Prepare your customized files, if any. Use the checklists in this chapter to 
decide which custom files you need to create. Chapters 5 through 8 
provide detailed instructions on specific file customizations.

Note that some customizations don’t require you to create a customized 
file first. For example, to change Navigator’s default home page or include 
your company name in the CD autorun screen, you simply enter this 
information directly into the tool and let the tool do the rest. See Table 1-1 
(page 34) for a list of quick customizations that you can enter directly into 
the CCK tool.

c. Start the CCK tool and create a new configuration for the installer you 
want to create first. Depending on how many installers you want to create 
and which platforms you want to support, you may have to run the CCK 
more than once and you may have to create more than one configuration. 

For more information about configurations and installers, see Chapter 3, 
“Using the Configuration Workspace for Customized Files” (page 55) and 
Chapter 4, “Preparing Operating System, Language, and Installer 
Information” (page 61).

d. Run the rest of the CCK tool.

Click Next on each screen after providing the appropriate information.

6. Build and test your installer. 

a. On the CCK tool's last screen, click Build Installer to create your Netscape 
installer.
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b. Run your custom installer and verify that all your customizations made 
with the CCK tool have taken effect correctly. For detailed instructions, see 
Chapter 10, “Verifying Your CCK Tool Customizations” (page 95). If you 
find any errors, fix the customized files involved (if necessary) and run the 
CCK tool again to regenerate the installer.

7. Make additional manual customizations. These can include advanced 
customizations for the CD autorun screen, turning of Netscape activation, and 
other tasks that require direct manipulation of the installation files. For 
detailed instructions, see Chapter 11, “Manually Customizing the CD Autorun 
Screen” (page 101) and Chapter 12, “Advanced Netscape Customizations” 
(page 121).

8. Test your manual customizations. Run your custom installer, verify that all 
your manual customizations to have taken effect correctly, and if necessary fix 
any customizations that have not taken effect. 

Important: If you make any manual customizations, do not run the CCK tool 
again for the same configuration, or it will overwrite all your manual 
customizations.

9. Prepare for distribution. Follow these steps:

a. If you want to distribute a customized Macintosh installer, follow the 
instructions in Chapter 13, “Preparing Macintosh Installers and Program 
Files” (page 129). 

b. Assemble your CD layout or make your network installer available on 
your FTP site for download.

If you're providing a CD-based installer, assemble a CD layout that 
consists of your Netscape installer, related Netscape installation files, and 
any other files you want to include on the CD. 

If you’re providing a network-downloadable installer, copy the installer 
and its associated files to your network's FTP server and provide users 
with instructions on how to download and run the installer.

Chapter 14, “Distributing Your Installers” (page 135) describes how to 
prepare your customized installation files for CD and/or online 
distribution.

c. If you’ve created a CD-based installer, prepare it for distribution to your 
customers. 
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10. Distribute Netscape and provide appropriate information to your customers 
regarding installation, initial account setup, and customer support. The steps 
a customer follows after receiving the a CD from an ISP typically go something 
like this:

a. Installs software (including but not necessarily limited to Netscape 7.0), 
either from a CD or over the network, according to instructions provided 
by the ISP.

b. Configures system and browser software for the new account.

Account setup can be done manually or automatically (with the aid of 
software provided by the ISP). Typically, it involves configuring dialer and 
modem software, TCP/IP settings, and Netscape 7.0 settings such as email 
address according to information provided by the ISP.

c. Connects with the ISP, logs in, and begins using the service.

Details of end-user instructions for installation and account setup vary widely 
among ISPs. To get you started:

❍ “Distributing Network-Downloadable Installers or Binaries” (page 
page 141) includes end-user network installation instructions for 
Windows, Macintosh, and Linux.

❍ Appendix B, “Manual Account Setup (page 149), summarizes the 
minimum information your customers need to set up their own accounts 
for your ISP business.

System Requirements
To use CCK , and to create and test a Windows installer, you need a system that 
meets these requirements: 

• Windows NT, Windows 2000, or Windows XP.

• Pentium 233 MHz (or faster) processor

• 64 MB of RAM (or greater)

• At least 80 MB hard disk space for installation

• At least 65 MB hard disk space for the installed directory and temporary files 
created by CCK
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To create a Linux installer, your Windows system must also meet these 
requirements:

• The GNU Tools for Microsoft Windows (the Cygnus toolkit) must be installed. 
You can obtain the Cygnus toolkit from

http://www.cygwin.com/

• The volume on which you install the CCK tool must have at least 108 MB of 
hard disk space in addition to the space described above, for these purposes:

❍ Linux Netscape 7.0 tar file: 45 MB. Note: this can be located on a different 
volume.

❍ Expanded Linux Netscape 7.0 files, extracted from the tar file: 45 MB

❍ Each Linux configuration created by CCK requires up to an additional 90 
MB

To create a Linux installer, download the standard Netscape 7.0 Linux tar file from 
http://channels.netscape.com/ns/browsers/partners.jsp to some 
convenient location before you run the CCK tool. (The standard Linux installation 
files are not included in the CCK package and must therefore be downloaded 
separately—unlike the Windows installation files, which are included with CCK.)

To test a Linux installer, you need a Linux system that meets these requirements:

• Red Hat Linux 6.0, 6.1, 6.2, or 7.0 with X11 R6. 

Note: Netscape 7.0 is certified and fully supported on Red Hat Linux, but will 
run on other Linux distributions, such as Debian 2.1 (or later) or SuSE 6.2 (or 
later). (The libraries glibc 2.1 (or higher) and libjpeg.so.62 (or higher) are 
required.)

• Pentium 233 Mhz (or faster) processor

• At least 64 MB RAM

• At least 27 MB hard drive space

To create and test a Macintosh installer you need a Macintosh system that meets 
these requirements: 

• Mac OS 9.x to complete custom installer creation with the customized file 
(CustomizedMacFiles.zip) which is started in CCK.

• Mac OS X.1 to test the customized build. Note that Netscape 7.0 browsers for 
Macintosh created with CCK have only been tested on Mac OS X
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• Power PC 604e 266MHz or faster processor, or G3/G4

• At least 64 MB of RAM

• At least 36 MB of free hard disk space

• At least 50 MB hard disk space for target and temporary files created by CCK

Important: The CCK tool works for only one version of Netscape. For example, in 
order to customize Communicator 4.x, you must use CCK 4.x, CCK 6.1 allows you 
to customize Netscape 6.1 only, and CCK 7.0 customizes only Netscape 7.0 
software. 

Platform Support
The CCK tool can produce installers that run on Windows, Linux, or Macintosh:

• If you set up your CCK configuration for Windows, the resulting installer runs 
on these platforms:

❍ Windows NT

❍ Windows 95

❍ Windows 98

❍ Windows 2000

❍ Windows ME

❍ Windows XP

• If you set up your CCK configuration for Linux, the resulting tar file can be 
unpacked and installed on Red Hat Linux 6.0, 6.1, 6.2, or 7.0 with X11 R6. 

• If you set up your CCK configuration for Windows, you can use the resulting 
files as described in Chapter 13, “Preparing Macintosh Installers and Program 
Files” (page 129), to create a customized Mac OS 9 installer or a customized 
version of Mac OS X.
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Installing the Client Customization Kit Tool
Before you install CCK, be sure to read the current Release Notes, which describe 
known problems and workarounds:

http://home.netscape.com/eng/mozilla/ns7/relnotes/cck.html

You must also sign up for the Browser Distribution program before you can use the 
CCK tool or distribute customized installers:

http://home.netscape.com/bisdev/distribution/index.html

To install the Client Customization Kit after you've downloaded the setup file:

• Double-click the file NSCCKsetup.exe.

• Follow the instructions provided by the installer program to install CCK.
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What Customizations Can I Make?
The CCK tool allows you to make any or all of the customizations listed in the 
following sections.

Netscape Navigator Customizations
The Netscape Navigator browser is generally the first screen users see when they 
start Netscape. Customizing the browser allows you to

• Bring users back to your web site (home page) every time they start Netscape 
or open a browser window.

• Create brand awareness and promote customer loyalty.

• Guide users to the web pages you want them to see.

Using the CCK tool, you can make these browser customizations:

• Insert your company’s logo to replace the animated Netscape logo in 
Navigator’s toolbar. When users click the logo, they’ll go to your home page:
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• Customize the bookmarks file and personal toolbar buttons.

• Add your company name to the browser window title bar and change 
Navigator’s default home page to your company’s home page.
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• Add an item to the Help menu that takes users to your online technical support 
page.
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• Include your own customized read-me file and add your company name to the 
program folder name in the Windows Start menu.
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• Add your own sidebar to those that are visible when the browser opens a new 
profile for the first time.

• Set default proxy preferences
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Mail and News Customizations
You can specify Mail and Newsgroup server settings to simplify account set up for 
your customers. For example, you can customize the options available on the New 
Account Setup wizard:

You can also specify domain names, servers, ports, and other details of the default 
settings the user will encounter while setting up mail and news accounts.

CD Autorun Screen Customizations
The CD autorun screen automatically appears when a user inserts a Netscape CD 
into a CD-ROM drive. Using the CCK tool, you can make these customizations to 
the standard CD autorun screen:

• customize the CD autorun screen’s background bitmap image

• provide your own title bar text and include a line of text below the title bar

• customize the contents of the installation guide text file
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This illustration shows some of the elements you can customize in the standard CD 
autorun screen:

Installer Customizations
CCK creates a Netscape installer that is both CD- and network-ready. Navigator is 
part of every installer. You can select which of the following components you want 
your installer to include:

• Sun Java 2

• Mail & Instant Messaging

• Quality Feedback Agent

• Spell Checker

• AOL ART Extensions

• Net2Phone

• Macromedia Flash Player

• AOL on Desktop
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• RealPlayer 8

• Viewpoint Media Player

• Winamp

• HP Printer Identifier Plug-in

• Classic Skin

• Canadian region pack

Some components are not available on all platforms. See Table 9-1 (page 92) for 
details.

Customization Services Options
If you don’t want to make the customizations yourself, Netscape To Go makes it 
easy, efficient, and economical for you to distribute customized versions of 
Netscape by providing these services: 

• Build a custom version of Netscape 7.0 to your specifications.

• Create custom-branded disc art and packaging using your company logo.

• Duplicate unlimited custom or standard CDs based on your requirements.

For more information and convenient online ordering, go to

http://www.netscapetogo.com/ 

Which Customizations Can I Make Quickly?
Some customizations don’t require you to create a customized file before you start 
using the CCK tool. If you just want to make some quick customizations, such as 
changing Navigator’s default home page or including your company name in the 
CD autorun screen, you simply enter this information directly into the CCK tool.

Table 1-1 summarizes the quick customizations you can make.

Table 1-1 Quick Customizations Checklist
Component What You Can Customize

CD autorun screen Display your company name on the CD autorun screen that users see 
when they insert the Netscape CD.
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Using the CCK Tool
To run the CCK tool, open the Start menu and choose Programs, then Netscape 7.0 
Client Customization Kit, NSCCKTool.

The CCK Tool uses a standard Wizard interface to guide you through the process 
of customizing Netscape 7.0. When you finish entering the information for a given 
screen, you click Next to proceed to the next screen. 

For a quick hands-on tour of the simplest customizations, see Chapter 2, 
“Customizing Netscape in Ten Minutes” (page 39)

Working with CCK Configurations
The first screen of the CCK tool includes a drop-down list that shows what 
configurations are available. You can work with configurations in the following 
ways:

• Choose an existing configuration from the drop-down list, and run the CCK 
Tool using that configuration.

To view the current settings for the selected configuration, click Show Config 
Info.

• Choose an existing configuration from the drop-down list, click Create a Copy, 
and run the CCK Tool using the copy. 

Help menu Add your own menu item and URL to Netscape’s Help menu. This URL 
can take users to your own online customer support page.

Navigator Change Navigator’s default home page.

Display your company name in the browser window’s title bar.

Append your company identifier to Navigator's user agent string.

Program folder name Append your company name to Netscape’s program folder name in the 
Windows Start menu.

Mail and News server settings Set the default domain and server settings for Netscape Mail and News.

Proxy Configurations Set up the default proxy configurations for Netscape.

Table 1-1 Quick Customizations Checklist
Component What You Can Customize
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This option lets you create a new customized installer that’s based on an 
existing configuration, without overwriting the existing configuration (similar 
to a Save As operation).

• Click New Configuration to create a new configuration, and run the CCK Tool 
using the new configuration.

For more information about CCK configurations, see Chapter 3, “Using the 
Configuration Workspace for Customized Files” (page 55).

Saving Changes
Each time you click Next in a CCK screen, the information you entered or changed 
on that screen is automatically saved with your configuration.

You can exit the tool at any time and continue working with your configuration 
later. 

To exit the CCK tool, click the Exit button on any screen. When you click Exit, the 
information you entered in previous screens (but not in the screen where you 
clicked Exit) is saved with your configuration.

You relaunch the tool at any time to continue entering information for that 
configuration.

Reviewing and Verifying Your Customizations
To review all the customizations you entered in the CCK tool before building your 
installer, click the Show Config Info button on the final Create the Installer screen. 
You can also go back to any screen and make additional changes before building 
your installer.

Your custom installer is created in

installation_directory\CCKTool\Configs\my_config\Output 

where installation_directory is the directory where you installed the CCK tool and 
my_config is the name of the configuration you are customizing.

Run your custom installer and verify that all your customizations have taken effect 
correctly. If you find any errors, fix the customized files involved (if necessary) and 
run the CCK tool again to regenerate the installer before proceeding with any 
manual customizations. 
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For more information about verifying the customizations you make with the CCK 
tool, see Chapter 10, “Verifying Your CCK Tool Customizations” (page 95).

Getting Help
To get help while using the CCK tool:

• Click the Help button in any of the main CCK tool screens for information 
about using that screen.

• To see an example of a particular customization, click the Show Example 
button.
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Chapter 2

Customizing Netscape in Ten
Minutes

This chapter shows you how to use the CCK tool to implement some of the 
simplest customizations—that is, those that don’t require you to prepare any files 
beforehand.

Other customizations that you can perform with the CCK tool, such as providing 
your own custom bookmarks or custom animated logo, require that you create 
customized files before you run the tool. Later chapters describe the preparations 
required for those customizations.

This chapter contains these sections:

What You’ll Customize
Quick Customization Instructions
Verifying Your Customizations

What You’ll Customize
This chapter describers how to create a CD-based Netscape installer for use on 
Windows that includes these customizations:

• Your company name displayed in these locations:

❍ Browser window’s title bar.

❍ CD autorun screen, which is the screen that users see when they insert the 
Netscape CD into a CD-ROM drive.

❍ Netscape program folder name that appears in the Windows Start menu.
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• The browser's default home page set to your own home page. The home page 
is the first page users see when they start Navigator and the page they see 
when they click the Navigator Home button.

• Mail and News server settings.

• Bookmarks, Personal Toolbar entries, and Sidebar tabs that connect your 
customers to links with content of your choosing.

• A Netscape installer that installs only the components you want users to have.

If these are the only customizations you need to make, your installer will be ready 
for packaging and distribution after you finish this chapter. 

Even if you plan to make some of the additional customizations that require 
preparing files, it’s still a good idea to follow the steps described in this chapter as a 
way of familiarizing yourself with the CCK Tool. Once you have prepared the 
additional files you need, you can run the tool again to add those customizations to 
the ones you make in this chapter.

Quick Customization Instructions
This section guides you through the process of running the CCK tool, which is 
basically the same whether you are performing the simple customizations 
described here or those requiring some file preparation as described in the chapters 
that follow. 

The examples shown in this section are based on the sample configuration 
provided with the tool for a hypothetical ISP called Mach Networks. You should, 
of course, enter the equivalent information for your own company in each screen.

The steps that follow describe how to create a customized Netscape installer that 
implements the simple customizations described in the previous section. 

1. Open the Start menu and choose Programs, then Netscape Client 
Customization Kit, then NSCCKTool.
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2. Welcome to the Netscape Client Customization Kit! On the first screen you 
see when you run the CCK Tool, click New Configuration, enter a name for the 
directory that the CCK tool will use to store your custom configuration 
information, and click Create New Configuration. Then click Next to continue.



Quick Customization Instructions

42 Guide to Customizing and Distributing Netscape 7.0 • August 2002

3. Specify Operating System and Language. You can choose to generate a 
Windows or a Linux installer. It’s also possible to create a Macintosh installer 
by manipulating the installation files produced for a Windows installer. You 
can also create installers in other languages.

For now, leave Windows as the operating system and English as the language. 
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4. Gathering Information. This screen specifies whether you want a CD-ready 
installer, the FTP or HTTP address, if any, you plan to use for a network-ready 
installer, and the company identifier that will appear as part of the user agent 
string.

❍ Confirm that the checkbox labeled “Include CD Autorun Screen” is 
selected.

❍ Enter your company identifier in the field for that purpose near the bottom 
of the screen

The company identifier you enter will be included as part of the user agent 
string, which helps identify the browser type each the browser accesses your 
web site or any other web site. Your identifier in the user agent string allows 
your company (or others) to track the number of times Internet web sites are 
accessed by web browsers that you've customized. 

The identifier you supply can be up to 10 characters in length. You must 
supply one.

For example, if you enter “MachNet” in the Company Identifier field, the 
resulting user agent string would look like this:  

Mozilla/5.0 (Windows; U; WinNT5.0; en-US; rv:1.0.1rc2) 
Gecko/20020823 Netscape/7.0 (CK-MachNet)
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When you are ready, click Next to register the customizations you’ve made on 
this screen and proceed to the next screen.

5. Customize the Netscape Browser - Part One. This screen allows you to 
customize the animated logo near the upper-right corner of the Navigator 
window and to add a Help menu item. 

For now, you won't be performing these customizations—but you can come 
back and do them later if you wish. Just click Next to proceed to the next 
screen.
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6. Customize the Netscape Browser - Part Two. This screen specifies the 
program folder name that appears under Start Menu/Programs, a custom 
read-me file, and the files to use for a custom animated logo. 

For now, just enter your company name in the Start Menu section, then click 
Next.
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7. Customize the Netscape Browser - Part Three. This screen specifies the 
default home page, bookmarks file, and title bar text.

❍ Under Default Home Page, enter the URL for the web page that you want 
to assign as Navigator’s default home page.
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❍ Under Browser Window’s Title Bar Text, enter your company name.

Click Next to continue.

Customize Bookmarks. This screen enables you to add a single bookmark, or a 
bookmark folder containing up to five bookmarks.

Under Bookmark Title, enter the name you want to appear in the Bookmarks 
menu. In the URL field, enter to URL to which you want the bookmark to 
connect.

Click Next to continue.
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8. Customize Netscape Mail. This screen specifies your mail domain and server 
information.

If you choose to provide customized mail settings, fill in every field in the 
Customize Netscape Mail screen. You must fill in all fields, otherwise no 
customized mail server settings will appear in your customized version of 
Netscape 7.0. 

For short descriptions of the information to enter in each field, click the Help 
button. For examples of the settings that each field controls, click the 
corresponding Show Example buttons. Click Next when you are finished.

IMPORTANT NOTE: If you customize Mail, you should disable Netscape 
activation after you create your custom Netscape installer. For details, see 
Netscape Activation Considerations for Mail and News (page 78).
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9. Customize Netscape News. This screen specifies your mail domain and server 
information.

If you choose to provide customized news settings, fill in every field in the 
Customize Netscape News screen. You must fill in all fields, otherwise no 
customized news server settings will appear in your customized version of 
Netscape 7.0. 

For short descriptions of the information to enter in each field, click the Help 
button. For examples of the settings that each field controls, click the 
corresponding Show Example buttons. Click Next when you are finished.

IMPORTANT NOTE: If you customize News, you should disable Netscape 
activation after you create your custom Netscape installer. For details, see 
Netscape Activation Considerations for Mail and News (page 78).
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10. Customize Proxy Configurations. This screen specifies the default proxy 
configurations that appear under the Advanced category when the user 
chooses Preferences from the Edit menu. 

For now, you won’t specify any proxy configurations. Click Next to continue.
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11. Customize the CD Autorun Screen. This screen specifies the background, title 
bar text, and installation text file for the CD autorun screen that appears when 
a user inserts the CD with your custom installer on it.

Under Title Bar Text, enter your company name as you want it to appear in the 
screen’s title bar and in the area below the title bar of the CD autorun screen. 
Then click Next to continue.
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12. Create the Installer. This screen specifies which Netscape 7.0 components you 
want to install and up to two additional installers to include with the Netscape 
7.0 installer. 

Deselect any components in the list on the left that you don’t want to include in 
your installer. 

Before building the installer, click To confirm the settings you have selected, 
click Show Config Info to confirm all the settings you’ve made to your 
configuration. If you see any errors, click the Back button repeatedly to return 
to the screen where the error occurred. After you’ve corrected any errors, click 
the Next button for each screen until you see the Create the Installer screen 
again.

If you are sure all your settings are correct, click Build Installer to create your 
customized Netscape 7.0 installer.

13. When the CCK tool informs you that your installer has been created, click OK. 
The CCK tool creates your installer files in this location (where 
installation_directory is the directory where you installed the CCK tool and 
my_config is the directory name you specified in the first screen):

installation_directory\CCKTool\Configs\my_config\Output
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Verifying Your Customizations
Once you’ve created a customized Netscape installer, you should install your 
customized software in the same way your users will, so you can verify that all 
your customizations appear exactly as you intended. Follow these steps:

1. Go to the directory that contains your customized installer and its associated 
files:

installation_directory\CCKTool\Configs\myconfig\Output

2. Double-click the file setup.exe. This causes the CD autorun screen to 
appear—the same screen your users will see when they insert the CD that 
contains your customized Netscape installer.

3. Examine the CD autorun screen to verify that it includes your company name 
in the title bar and in the area below the title bar.

4. Click Install Netscape 7.0 to launch the installer. Choose the Custom 
installation path so you can verify that the components installed by default are 
the same ones that you selected using the CCK tool.

5. After the installation is complete, the browser launches and the Netscape 
Activation screen occurs. If you have customized any mail and news settings, 
be sure to cancel the Activation screen. 

As noted earlier in this chapter, if you customize Mail or News, you should 
disable Netscape activation after you create your custom Netscape installer. 
For details, see Netscape Activation Considerations for Mail and News 
(page 78).

6. Choose About Netscape 7.0 from the Help menu and verify your customized 
user agent string, which should appear near the top of the window. For the 
Mach Networks example, :

Mozilla/5.0 (Windows; U; WinNT5.0; en-US; rv:1.0.1rc2) 
Gecko/20020823 Netscape/7.0 (CK-MachNet)

7. Verify that the Netscape program folder name in the Windows Start/Programs 
menu includes your company name.

8. Click the Home button in the Navigator browser to verify that it takes you to 
the URL you specified, and check the browser window title bar to verify that it 
includes your company name.

9. Verify that the Mail and News account settings are correct.

That’s all there is to it. If these are the only customizations you want to make, 
you’re ready to begin preparing for distribution:
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• If you want to create a Linux or Macintosh installer, see Chapter 4, “Preparing 
Operating System, Language, and Installer Information.” (page 61).

• If you want to create a Macintosh installer, you should also see Chapter 13, 
“Preparing Macintosh Installers and Program Files” (page 129).

• When you are ready to distribute your installers, see Chapter 14, “Distributing 
Your Installers” (page 135).
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Chapter 3

Using the Configuration Workspace
for Customized Files

As you saw in Chapter 2, “Customizing Netscape in Ten Minutes,” the first screen 
presented by the CCK tool allows you to select a configuration (or create a new 
one). Each configuration available to the CCK tool has a corresponding directory 
where the installer for that configuration resides.

The configuration directory also includes a Workspace directory. If you need to do 
create an animated logo or customize bookmarks, the default My Sidebar tabs, the 
read-me file, and other aspects of Netscape 7.0. that require you to prepare files 
before running the CCK tool, you can use the Workspace to store your customized 
files while you work on them.

This chapter describes the contents of the configuration directory, the files you can 
customize, and where to store them in the Workspace directory. The chapters that 
follow summarize how to prepare the information and files relevant to each of the 
remaining screens presented by the CCK tool.

This chapter contains these sections:

Creating a New Installer Configuration
The Configuration Directory
Customized Files Checklist
Platform and Configuration Information
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Creating a New Installer Configuration
The first screen of the CCK tool includes a drop-down list (near the lower-left 
corner) that allows you to select a configuration. You can also use this screen to 
create a new configuration or create a copy of an existing configuration. 

Each configuration name in the drop-down list corresponds to a configuration 
directory of the same name (described in detail in the section that follows). A 
configuration directory stores both customized files that you supply for use by the 
CCK tool and the customized Netscape 7.0 installation files created by the CCK 
tool.

The CCK tool applies the customizations you specify to the configuration selected 
in the first screen. If you are customizing features that require you to prepare 
custom files in advance, you should prepare and verify those files before you run 
the tool.

The rest of this chapter describes the layout of the configuration directory and 
summarizes the files you must prepare for various customizations. The chapters 
that follow describe how to prepare the customized files for the customizations you 
can specify with the CCK tool.

The Configuration Directory
Each configuration name listed in the drop-down list on the first screen of the CCK 
tool corresponds to a directory name in this location:

installation_directory\CCKTool\Configs\my_config\

After you run the CCK tool for a given configuration, the corresponding 
configuration directory contains the following subdirectories and files (assuming 
the configuration includes a CD autorun screen as well as a network installer):

• Output contains all customized installation files:

❍ Core 

❍ Shell

❍ autorun.inf 

❍ install.txt 

❍ launch.ini 

❍ setup.exe 
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• Workspace includes the following subdirectories for storing your customized 
files: 

❍ AnimLogo stores the .GIF files associated with the animated logo button. 
See Customizing the Netscape Browser for the instructions to create these 
files.

❍ Autorun stores a custom background image for the CD autorun screen. See 
Customizing the CD Autorun Screen  for the instructions to create the 
custom files.

In the default and sample Mach Networks configurations, license.txt and 
readme.txt (the Netscape license and read-me files) are located in the Output 
directory. In all other configurations, these two files are located one level higher (in 
the my_config directory). 
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Customized Files Checklist
Table 3-1 lists the customizations that require customized files and where to find 
information about preparing those files.

Table 3-1 Netscape 7.0 customized file checklist

To make this Netscape 
customization

You’ll need to provide Location in 
Workspace 
directory

Chapter in this guide

Animated logo Animated and at-rest GIF files 
(32 x 32) for the animated logo

AnimLogo Chapter 5, “Preparing to 
Customize the Netscape 
Browser” (page 67)

Custom background 
graphic for CD autorun 
screen (for CD-based 
installers)

640 x 480 bitmap file 
containing your custom 
background image

Autorun Chapter 8, “Preparing to 
Customize the CD Autorun 
Screen” (page 83)

Custom installation text file install.txt CustInst Chapter 8, “Preparing to 
Customize the CD Autorun 
Screen” (page 83)

Additional installers The setup.exe for each 
additional installer (up to two)

CustInst Chapter 9, “Preparing to 
Create the Installer” 
(page 91)

Custom Read-me file readme.txt top level of 
Workspace 

Chapter 5, “Preparing to 
Customize the Netscape 
Browser” (page 67)
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Platform and Configuration Information
Table 3-2 summarizes the Netscape 7.0 customizations you can make with the CCK 
tool and the platforms on which they are supported. 

 

Table 3-2 Summary of CCK tool customizations

CCK Customization Windows Linux Mac OS

Read-me file Yes No No

CD autorun screen Yes No No

Network-ready installer Yes No No

Selecting and deselecting 
components

Yes Yes No

Additional (third party) 
components

Yes No No

Animated GIF file of 
product logo in Modern 
theme

Yes Yes Yes

Static GIF file of product 
logo in Modern theme

Yes Yes Yes

Help menu item text and 
help menu item URL

Yes Yes Yes

Sidebar tabs Yes Yes Yes

Default home page URL Yes Yes Yes

Bookmarks Yes Yes Yes

Browser window’s title 
bar text

Yes Yes Yes

Mail settings Yes Yes Yes

News settings Yes Yes Yes

Proxy settings Yes Yes Yes
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Chapter 4

Preparing Operating System,
Language, and Installer Information

The second and third screens presented by the CCK tool allow you to choose a 
platform and specify other basic information about your installer.

This chapter describes the information you need to prepare for these initial screens. 
It contains these sections:

Deciding What Kinds of Installers to Create
Choosing a Company Identifier
Checklist for Platform and Installer Screens

Specifying an Operating System
The CCK tool can generate an installer for use on Mac OS, Windows, and Linux. 

Windows
No special preparation is required to create a Windows installer; from the second 
screen of the CCK tool, titled Specify Operating Sytsem and Language, select 
Windows from the drop-down list.

The Windows installation files produced by the CCK tool will run on these 
systems:

• Windows NT

• Windows 95

• Windows 98
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• Windows 2000

• Windows ME

• Windows XP

Linux
To prepare a Linux installer, first download a Netscape 7.0 Linux tar file to some 
convenient location. 

After you choose Linux as the operating system for the current configuration on 
the second screen of the CCK tool, called Specify Operating System and Language, 
you can specify that location in the field provided.

You need to specify the location of the Linux tar file only once. After you do so, the 
CCK tool creates a directory CCKTool\nscpxpiLinux\ and stores the 
decompressed standard Linux installation files there. 

If you decide later that you want the CCK tool to start fresh with a Linux tar file, 
you must delete the directory CCKTool\nscpxpiLinux\ and its contents. The next 
time you run the CCK tool, you will again be able to specify the location of the 
Linux tar file.

In addition to downloading a Netscape 7.0 Linux tar file, you must have GNU 
Tools for Microsoft Windows (the Cygnus toolkit) installed on the system before 
running the CCK tool. You can obtain the Cygnus toolkit from 
http://www.cygwin.com/. You must also make sure that the path to the binaries 
for the Cygwin Unix programs is included in the Windows environment variable 
called PATH. To check the PATH variable, open the System control panel and click 
the Environment tab.

After you click the Build Installer button on the last screen of the CCK tool, the tool 
provides the customized Linux build as a tar file in

CCKTool\Configs\my_config\Output

You can then transfer this tar file to a Linux system and then extract the contents 
for testing. 

Macintosh
To prepare a Macintosh OS X installer, from the second screen of the CCK tool, 
titled Specify Operating Sytsem and Language, select Mac OS from the drop-down 
list.
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To create a Mac OS 9 installer, follow the instructions in Chapter 13, “Preparing 
Macintosh Installers and Program Files” (page 129).

Deciding What Kinds of Installers to Create
The CCK tool lets you create two types of installers: 

• CD-based installers, for distributing Netscape to your users on a CD

• Network-downloadable installers that users can download from your network, 
and then install Netscape on their hard disks. 

The advantages and disadvantages of each type of installer are described in the 
sections that follow.

IMPORTANT NOTE: If you have customized Mail and News, you should disable 
Netscape activation before you make any form of Netscape installer available, or 
else provide your users with additional instructions. This applies to Linux, 
Windows, and Macintosh installers. For details, see “Netscape Activation 
Considerations for Mail and News (page 78).

Providing a CD-Based Installer
Distributing your Netscape installer on a CD has these advantages:

• It’s the best way to distribute Netscape to users who don’t have Internet access 
or who are new to the web.

• It's convenient; all the software users need to get started is included on the CD.

• When a user inserts the CD in a CD-ROM drive, the CD autorun screen 
automatically appears, simplifying installation.

• You can customize the CD autorun screen to make it easy for users to install 
any other software you want to include on the CD along with Netscape.

• You can customize the CD autorun screen to promote your company’s 
products, services, and brand identity.

The main disadvantage of distributing Netscape on a CD is you may need to 
update and re-distribute the CD as newer versions become available.
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User Experience of CD-Based Installation
If you've chosen to include the CD autorun screen with your CD-ready installer, it 
automatically launches when the user inserts the CD. The user can then follow the 
instructions on the CD autorun screen to install your customized version of 
Netscape.

If you’ve customized the CD autorun screen, either by using the CCK tool or by 
making manual customizations (as described in Manually Customizing the CD 
Autorun Screen), users will see your customized CD autorun screen instead of the 
standard one.

If for some reason the CD autorun screen is included with the installer but doesn’t 
automatically appear when the user inserts the CD, the user must double-click the 
setup.exe file (Windows) or Netscape 7.0 Installer file located at the CD root to 
launch the CD autorun screen.

If you’ve chosen not to include the CD autorun screen, to launch the network 
installer the user must double-click the setup.exe file (Windows) in the root level 
of the Output directory or the Netscape 7.0 Installer file located at the CD root. 

For Mac OS X, the customized files do not require installation: the user simply 
copies them to a convenient location and double-clicks the Netscape application 
icon to launch Netscape. 

To run the Linux installer, the user must run the install script by typing the 
command ./netscape-installer. 

Providing a Network-Downloadable Installer
If you distribute your Netscape installer over a network, you don’t have to pay for 
postage, packaging, and CD duplication. Also, as new versions of Netscape 
become available, you can readily provide them on your web site.

Since users must already have Internet access, distributing Netscape over a 
network is primarily useful for upgraders or users who want to switch to Netscape 
from another web browser. Also, users must have a modem capable of transferring 
data at a rate of 56 Kbps or faster to keep the download time within acceptable 
limits.
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Table 4-1 lists approximate download times for an installation that includes 
Navigator and Mail only (approximately 11 MB). Actual download times may 
vary.

To distribute a network-downloadable installer, you’ll need to set up an HTTP or 
FTP (File Transfer Protocol) site so users can download the Netscape installer from 
your site. You’ll also need to tell users where to find the installer and provide them 
with instructions for downloading it.

User Experience of Network-Downloadable Installer (Windows)
To install Netscape on Windows, a user

1. Launches another browser or HTTP or FTP program and downloads a small 
(approx. 300 Kbytes) installer program (NSSetup.exe) from your FTP site to 
the user’s hard disk.

2. Double-clicks the N6Setup.exe program to begin the installation process. The 
NSSetup.exe program displays a series of screens that guide the user through 
the entire installation process.

3. During the installation process, the installer downloads the necessary Netscape 
component files from your FTP site and installs them on the user’s machine. 
While downloading is in progress, the user can pause the download process 
and resume the download later.

4. When the installation is complete, Netscape launches.

Table 4-1

Transfer speed (in Kbits/second) Transfer rate  Download time (in minutes)

28.8 Kbps 4.86 minutes/MB 53.4 minutes

36.6 Kbps 3.82 minutes/MB 42.01 minutes

56 Kbps 2.47 minutes/MB 27.1 minutes

64 Kbps ISDN 2.2 minutes/MB 24.2 minutes

128 Kbps ISDN 1.09 minutes/MB 11.9 minutes

144 Kbps DSL/Cable modem .97 minutes/MB 10.6 minutes
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Choosing a Company Identifier
The only required item on the Gathering Information screen is your company 
identifier for the user agent string. The user agent string helps identify the browser 
type whenever the browser accesses your web site or any other web site. Your 
identifier in the user agent string allows your company (or others) to track the 
number of times Internet web sites are accessed by web browsers that you've 
customized. 

The identifier you supply can be up to 10 characters in length.

For example, if you enter machnet in the Company Identifier field, the resulting 
user agent string would look like this: 

Mozilla/5.0 (Windows; U; WinNT5.0; en-US; rv:1.0.1rc2) 
Gecko/20020823 Netscape/7.0 (CK-MachNet)

If you are preparing several different customized versions of Netscape, you may 
want to supply a different user agent string for each one.

Checklist for Platform and Installer Screens
The Specify Operating System and Language screen specifies:

• Whether you want the CCK tool to generate a Windows, a Macintosh, or a 
Linux installer. The Linux option appears only after you download the tar file.

• The location of the standard Linux tar file for Netscape 7.0 (if you select Linux 
as the platform).

The Gathering Information screen specifies:

• Whether you want a CD autorun screen.

• The FTP or HTTP URL for an network-ready installer (if any).

• The company identifier to be included in the user agent string for your 
customized Netscape (required).

Make sure you have this information available when you run the CCK tool.
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Chapter 5

Preparing to Customize the Netscape
Browser

The CCK tool presents three screens that allow you to customize different aspects 
of Navigator, the Netscape browser. This chapter describes the information and 
files you need to prepare for these three screens.

This chapter contains these sections:

Creating a Custom Animated Logo
Determining a Help URL and Menu Item
Determining the Name of the Program Folder in the Windows Start Menu
Preparing a Customized Read-me File
Creating Your Own Sidebar Tab
Specifying the Default Home Page
Determining Text for the Browser Window’s Title Bar
Checklists for Customizing the Browser

Creating a Custom Animated Logo
You can replace the standard Netscape animated logo that appears in the 
Navigator browser, Netscape Mail, and Netscape Instant Messenger windows with 
an animated logo for your own company, such as this one for Mach Networks:
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If you wish, you can also change the URL for the animated logo button to the URL 
for your home page, so that when users click the animated logo, they go to your 
home page instead of home.netscape.com.

The animated logo consists of a composite .GIF file that contains two or more 
individual .GIF images, or frames, laid end-to-end. When the individual frames in 
the composite .GIF file are displayed in rapid succession, one after the other, the 
logo graphic takes on the appearance of motion.

Here is a series of separate .GIF files that can be used to construct an animated 
.GIF file:

To create your own animated logo, you’ll need these tools:

• A graphics editing program or 3D animation program to create the individual 
.GIF files, or frames.

• A .GIF file animation program that assembles individual .GIF files into one 
continuous animated .GIF file.

You’ll need to create the following:

• A static .GIF file (32 by 32 pixels) for the at-rest logo.

• An animated .GIF file (32 by 32 pixels) for the animated logo.

The browser uses the static .GIF file whenever the animated logo is at rest (not 
animating). When both files are ready, put them in the Workspace\AnimLogo 
directory for your configuration.

The sections that follow outline the steps involved in creating your static and 
animated .GIF files.

Step 1: Create the Animation Frames
You'll need to create the following .GIF files (frames):

• Up to 40 (32 pixels by 32 pixels) .GIF files for assembling into the animated 
logo

• One GIF file (32 pixels by 32 pixels) that will be used as the "still" image when 
the animation is at rest
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Using a graphics editing program or a 3D animation program, create and save each 
individual animation frame as a separate .GIF file. Keep the animation as simple as 
possible by using the fewest number of frames that convey the motion you want to 
achieve.

Follow these guidelines:

• Create no more than 40 frames (files) for the animated logo

• Save your files in .GIF format

• Use no more than 30 colors in each file; 16 colors are best.

Step 2: Assemble Your Frames Using a GIF 
Animation Program
Using your GIF file animation program:

1. Assemble the animation frames in the order in which you want them to 
appear.

2. Set the duration that each frame will appear.

3. Set the animation to loop infinitely.

4. Preview the animation and make any changes until you're satisfied with the 
results.

5. Save the animation as a .GIF file.

6. Optimize the animation file. Most .GIF animation programs allow you to 
perform some optimization operations that will reduce the size of your 
animation file.

Note: The animation will play more slowly on computers with slower processors.

Determining a Help URL and Menu Item
The CCK Tool allows you to add a Help menu item to the Help menu. The name 
you specify appears as a new menu item above the Release Notes menu item near 
the bottom of the browser's Help menu. For example: My ISP Customer Support.

If you specify a new Help menu item, you must also specify a live URL for the page 
to which your menu item will take users and provide appropriate content for that 
page.
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Determining the Name of the Program Folder in 
the Windows Start Menu

To increase customer awareness of your company name and promote your 
company’s identity to your customers, you can add your company name to the 
Netscape 7.0 program folder name in the Windows Start menu.

For example, if you specify Mach Networks for use with the Start menu, the 
program folder name in the Start menu appears as “Netscape 7.0 by Mach 
Networks” as shown here:
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Preparing a Customized Read-me File
Netscape includes a standard read-me file, which you might want to customize if 
you want to provide additional information to your customers.

Under the terms of the Browser Customization Guidelines, you can edit the 
existing read-me file or replace it with one of your own, but you must not rename 
it.

To edit the read-me file:

1. Locate the standard Netscape Read Me (readme.txt) file:

installation_directory\CCKTool\Configs\Default\Workspace

where installation_directory is the directory where you installed the CCK tool.

2. Copy the readme.txt file to your own Workspace directory

installation_directory\CCKTool\Configs\my_config\Workspace

where my_config is the name of the configuration you are customizing.

Using a standard text editor such as WordPad, edit readme.txt or replace its 
contents with your own information. When the file is ready, put it at the top level 
of the Workspace directory for your configuration (for easy access when you run 
the CCK tool).

Creating Your Own Sidebar Tab
My Sidebar tabs provide a place within the Netscape 7.0 browser for users to keep 
connected to what is most important to them. Tabs are a great place for favorite 
information, such as stock quotes, local weather, news headlines, sports headlines, 
local events, or horoscopes. Users can choose from a wide variety of tabs in the My 
Sidebar Directory.

Netscape 7.0 comes with several sidebar tabs already set up. However, you can 
customize the browser by adding, removing, and rearranging tabs for your users. 
By creating a sidebar tab, you give your content constant presence within the user's 
client software. This means that users always have access to your service or content 
even when they are on another web site or using email. Links in your tab can lead 
back to your web site, driving increased traffic; and you can reduce service calls by 
making technical information easily accessible through your sidebar tab.



Creating Your Own Sidebar Tab

72 Netscape 7.0 Guide to Customizing and Distributing Netscape 7.0 • August 2002

The sidebar appears on the left side of Navigator, Mail, and Instant Messenger 
windows of Netscape 7.0. Here’s an example of a custom sidebar tab for Mach 
Networks:

To create a sidebar tab, see the instructions posted at

http://home.netscape.com/sidebar

To add a sidebar tab, create your tab, and in the CCK tool on the fifth screen, 
“Customize the Netscape Browser - Part Two,” enter the tab title and the URL for 
the tab.

To add multiple tabs, or to rearrange tabs, see the following sections.
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Specifying the Default Home Page
There are many advantages to leaving the default home page as it is. The Netscape 
web site provides a huge range of links and services, and you can provide these 
two your customers at no extra cost simply by leaving the default home page as it 
is. 

However, if you wish to change the home page to a URL of your choice, you can do 
so by typing the URL in the CCK tool screen entitled “Customize the Browser - Part 
Three.” The URL you specify determines both the first page launched and the page 
users will see when they click the Home button.

Determining Text for the Browser Window’s Title 
Bar

You can add your company name to the browser window’s title bar, so that your 
company name appears at the top of every browser window. For example, this 
illustrates the customized browser window's title bar for a company called Mach 
Networks:

If you decide you want to customize the browser in this way, you simply specify 
your company name when the CCK tool displays the screen entitled “Customize 
the Browser - Part Three.”

Checklists for Customizing the Browser

Customize the Browser - Part One
The screen called Customize the Browser - Part One specifies this information:
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• Animated logo:

❍ Logo button URL

❍ Path to animated GIF file (stored in Workspace\AnimLogo)

❍ Path to “at rest” GIF file (stored in Workspace\AnimLogo)

• Help Menu Item:

❍ Menu item text

❍ Menu item URL

Customize the Browser - Part Two
The screen called Customize the Browser - Part Two specifies this information:

• Text added to “Netscape by” in the name of the Netscape program folder in the 
Windows Start menu

• Path to custom read-me file (stored at top level of Workspace)

• URL and title for a customized sidebar tab

Customize the Browser - Part Three
The screen called Customize the Browser - Part Three specifies these 
customizations:

• Default home page URL (first page launched and Home button)

• Text that appears after the page title in the title bar

• URLs and titles for customized personal toolbar entries
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Chapter 6

Preparing to Customize Netscape
Mail and News

The CCK tool includes two screens that enable you to specify default domain and 
server settings for new mail and news accounts created with your customized 
version of Netscape. This chapter describes the information you need to have on 
hand if you want to customize these mail and news settings.

This chapter contains these sections:

Specifying Mail Domain and Server Settings
Specifying News Domain and Server Settings
Netscape Activation Considerations for Mail and News
Checklists for Customizing Mail and News

Specifying Mail Domain and Server Settings
Before specifying custom mail domain and server information, you should set up 
and test your mail server and confirm the settings described here. 
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Domain Settings
The CCK tool allows you to specify this mail domain information:

• Domain name. The default email domain that you want to appear in the 
Netscape Mail account settings. For example, if you enter "mach-networks.net" 
in this field, Netscape automatically appends each user's name with 
"@mach-networks.net" when your users set up their accounts. The domain 
name field also determines default domain values in the instructions that 
appear on the Identity screen of the Account Wizard, which leads users 
through the process of setting up their mail accounts.

• Display name. The mail account name that you want to appear as the Mail 
Folder in the left frame of the main Netscape Mail screen. For example, "Mach 
Networks Mail".

• Mail provider. The mail provider name that you want to appear in the New 
Account Setup screen, where users are prompted to select the type of account 
that they would like to set up, such as a newsgroup, email, or Webmail. This 
screen includes a variety of options; choices include AOL and Netscape 
accounts, so the more specific you make this text, the more helpful to your 
customer. For example, to be consistent with other choices on this account 
setup list, you might specify a name such as "Mach Networks Mail Account".

Incoming Server Settings
The CCK tool allows you to specify default settings for the incoming mail server. 
These settings appear in the Server Settings section of each new mail account listed 
under Mail & Newsgroups Account Settings. To view these settings in Netscape:

1. In the Netscape Mail & Newgroups window, open the Edit menu and choose 
Mail & Newsgroups Account Settings.

2. Click Server Settings.

These are the default Server Settings that you can specify with the CCK tool:

• Server name. The name of the incoming server. For example: 
mail.mach-networks.net

• Port number. The port for the incoming server. For POP, the standard port 
number is 110; this value is pre-filled in the CCK tool; you can change it if 
desired.
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• Server type. Choose POP or IMAP. If you choose POP, you can also choose to 
leave messages on the server even after the user deletes them in the Netscape 
Mail program.

Outgoing Server Setting
The CCK tool allows you to specify the default outgoing mail server. This setting 
appears in the Outgoing Server (SMTP) section under Mail & Newsgroups 
Account Settings. 

To view the Outgoing Server (SMTP) panel:

1. In the Netscape Mail & Newgroups window, open the Edit menu and choose 
Mail & Newsgroups Account Settings.

2. Click Outgoing Server (SMTP).

You specify only the Outgoing Server name with the CCK tool:

• Server name. The name of the outgoing SMTP server, for example, 
smtp.mach-networks.net.

Specifying News Domain and Server Settings

Domain
The CCK tool allows you to specify the following News domain information:

• Domain name. Enter the default News domain that you want to appear in the 
Netscape newsgroup account settings. Note that this domain name must be 
different than the domain name you used for Mail. For example, if your mail 
domain is "mach-networks.net," a news domain of "mach-networks.news.net" 
would work, but "mach-networks.net" would not.

The domain name field also determines default domain values in the 
instructions that appear on the Identity screen of the Account Wizard, which 
leads users through the process of setting up their news accounts.

• Display name. The News account name that you want to appear near the 
bottom of the left frame of the main Netscape Mail screen. For example, "Mach 
Networks News".
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• Mail provider. The News provider name that you want to appear in the New 
Account Setup screen, where users are prompted to select the type of account 
that they would like to set up, such as a newsgroup, email, or Webmail. This 
screen includes a variety of options; choices include AOL and Netscape 
accounts, so the more specific you make this text, the more helpful to your 
customers. For example, to be consistent with other choices on this account 
setup list, you might enter a string such as "Mach Networks News Account".

News Server (NNTP)
The CCK tool allows you to specify the following News server information:

• Server name. The name of the News server. For example: 
mach-networks.news.net

• Port number. The port for the News server. The standard port number is 119.

Netscape Activation Considerations for Mail and 
News

By default, when Netscape launches a new profile, it displays the Netscape 
Activation screen. Users who choose to accept activation are then prompted to 
register for Webmail and other Netscape services. 

If you customize Mail or Newsgroups, you should disable Netscape activation. If 
you don't disable activation and your customer chooses to activate Netscape 
Webmail, then the initial Account Setup screens will prompt the customer to 
complete Webmail account setup rather than your customized account setup.

To set up your mail account at this point, your customer must open the Edit menu, 
choose Mail & Newsgroup Account Settings, click on the New Account button, and 
then select your customized account option. After completing the customized 
account setup, the customer must click Set as Default button to make the new 
account the default mail account.

To avoid forcing your customers through this procedure, you should either tell 
them to cancel Netscape activation when they first launch Netscape, or turn off 
activation yourself in the installers you distribute.

Turning off Netscape activation involves manual customization of the installer files 
produced by the CCK tool. For detailed instructions, see Chapter 12, “Advanced 
Netscape Customizations (page 121).



Checklists for Customizing Mail and News

Chapter 6 Preparing to Customize Netscape Mail and News 79

Checklists for Customizing Mail and News

Customize Netscape Mail
The screen “Customize Netscape Mail” specifies this information:

• Domain

❍ Domain name

❍ Display name

❍ Mail provider

• Incoming Server

❍ Server name

❍ Port number

❍ Server type

• POP (with option to messages on the server)

• IMAP

• Outgoing Server (SMTP)

❍ Server name

Customize Netscape News
The screen “Customize Netscape News” specifies this information:

• Domain

❍ Domain name

❍ Display name

❍ News provider
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• News Server

❍ Server name

❍ Port number
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Chapter 7

Preparing to Customize Proxy
Configurations

The CCK tool includes a screen, Customize Proxy Configurations, that specifies the 
same settings available in the Advanced/Proxies section of the Netscape 7.0 
Preferences dialog box. 

This chapter contains these sections:

About Proxy Configurations
Default Network Proxy Configurations

About Proxy Configurations
Many organizations block access from the Internet to their networks. This prevents 
outside parties from gaining access to sensitive information. The protection is 
called a firewall.

If your organization has a firewall, the browser may need to go through a proxy 
server before connecting your users to the Internet. The proxy server prevents 
outsiders from breaking into your organization's private network.
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Default Network Proxy Configurations 
The CCK tool allows you to choose among the proxy configuration options listed 
below. They are identical to the options available in the Advanced/Proxies section 
of the Netscape 7.0 Preferences dialog box. To see this section:

1. Open the Edit menu and choose Preferences.

2. Click the Advanced category. If no subcategories are visible, double-click the 
category to expand the list.

3. Click Proxies.

These are the default options for the Proxies preferences panel that you can set in 
the CCK tool:

• Direct connection to the Internet. Choose this option if your users don't have 
to go through a proxy.

• Manual proxy configuration. Choose this option if your users don't have a 
proxy configuration file. Type the name or numeric IP address of the proxy 
server for HTTP and FTP. Type each proxy server's port number in the Port 
field.

In the “No Proxy for:” field, type the names of any domains that your users can 
connect to directly, bypassing the proxy. For example, if you type 
netscape.com, then the proxy is bypassed each time your users view a web 
page from netscape.com.

Domain names are the part of a URL that contains the name of an organization, 
business, or school—such as netscape.com or washington.org. If you use 
local host names without the domain name, list them the same way. Use 
commas to separate multiple host names. The wildcard character [*] cannot be 
used.

• Automatic proxy configuration URL. Choose this option if you have a proxy 
configuration file. 
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Chapter 8

Preparing to Customize the CD
Autorun Screen

The CCK tool screen called Customize the CD Autorun Screen specifies 
background image and text customizations for the CD autorun screen, which 
appears automatically when users insert your customized Netscape CD into a 
CD-ROM drive.

This chapter describes the information and files you need to prepare if you want to 
customize the CD autorun screen. It includes these sections:

What Is the CD Autorun Screen?
Customizing the CD Autorun Screen's Background Image
Customizing Text for the CD Autorun Screen
Customizing the Installation Document
Checklist for Customize the CD Autorun Screen

What Is the CD Autorun Screen?
If you plan to create Netscape installers for CD distribution, you can provide a CD 
autorun screen that automatically appears when the user inserts your customized 
Netscape CD into a CD-ROM drive.

The CD autorun screen makes it easy for your users to install Netscape or to read 
installation instructions before they begin the installation process.
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About the Default CD Autorun Screen
The CCK tool provides a default CD autorun screen that’s ready to use:

Customizing the Standard CD Autorun Screen
Customizing the standard CD autorun screen is optional. If you wish, you can use 
the CCK tool to customize the following items in the standard CD autorun screen:

• The background image that appears in the CD autorun screen

• The text inside and below the screen's title bar

• The contents of the installation text file (install.txt)
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Here is an example of a CD autorun screen that was customized by the CCK tool:

After you create your CD-based installer using the CCK tool, you can make 
additional manual customizations to the CD autorun screen, such as adding new 
screens or buttons. For more information, see Chapter 11, “Manually Customizing 
the CD Autorun Screen.” (page 101).
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Customizing the CD Autorun Screen's 
Background Image

You can customize the CD autorun screen's background image if you want to add 
your company logo or add other images that promote your company's identity.

The standard background image for the CD autorun screen consists of a 640 pixel 
by 480 pixel bitmap (.BMP) file, as illustrated here:

The easiest way to customize the background image is to edit the existing 
background image, called install.bmp, as described in the next section. If you 
prefer, you can substitute your own custom file as described under “Creating Your 
Own Custom Background Image” (page 87).

Editing the Standard Background Image
To edit the standard background image:

1. Locate the standard background bitmap file:

installation_directory\CCKTool\Configs\my_config\Workspace\Autorun\
Shell\bmps\install.bmp
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where installation_directory is the directory where you installed the CCK tool and 
my_config is the name of the configuration you are customizing. 

2. Using a graphics editing program, open the install.bmp file and make your 
changes to it. For example, you might want to add your company's logo and 
name.

Note: Do not add text or graphics within the black border area at the bottom of 
the CD autorun screen. This area is reserved for the CD autorun screen's 
Browse CD, Back, and Exit buttons.

3. Save your changes, making sure to save the file in .BMP format. If you want, 
you can save the file using another name.

In the CCK tool, go to the screen titled "Customize the CD Autorun Screen."

4. Under Background Bitmap, click Choose File and browse to the location of 
your custom background image to include it.

Creating Your Own Custom Background Image
To create your own custom background image for the CD autorun screen:

1. Using a graphics editing program, create a bitmap image that's 640 pixels wide 
and 480 pixels high.

Keep the size of the file as small as possible (325 Kbytes or less) by reducing the 
number of colors in the file, or by removing or flattening the layers (if you 
created the image in Photoshop). If your file size is too large, it may not appear 
in the CD autorun screen.

2. At the bottom of the background image, create a rectangular border at least 40 
pixels high and 640 pixels wide. The CD autorun screen will use this area to 
display the CD control buttons (Browse CD, Back, and Exit).

3. Save the image as a .BMP (bitmap) format file here:

installation_directory\CCKTool\Configs\my_config\Workspace\Autor
un\Shell\bmps\install.bmp

where installation_directory is the directory where you installed the CCK tool 
and my_config is the name of the configuration you are customizing.

Your background bitmap image is now ready to specify when you run the CCK 
tool.
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Customizing Text for the CD Autorun Screen
The CCK tool’s CD autorun screen specifies two text strings for the CD Autorun 
Screen:

• Title bar text. Text that appears in the CD autorun screen’s title bar after 
“Netscape by”. For example, if you enter “Mach Networks” the title bar text 
will read “Netscape by Mach Networks”.

• Text below title bar. Text that appears just below the title bar. For example: 
“Welcome to the Mach Networks Installer for Netscape 7.0.”

You should decide on the exact wording of these strings before you run the CCK 
tool.

Customizing the Installation Document
The CD autorun screen includes a button that, when clicked, opens a text 
document that contains instructions for installing Netscape. You might want to 
include additional information in this document that you want your users to know 
before they install.

For example, you could add information on your products and services, and tell 
users how they can contact you for more information. If you're planning to include 
installers for additional programs as part of your Netscape installer, this document 
is a great place to tell your users about the additional programs you're providing.

To edit the installation document:

1. Locate the standard installation document:

installation_directory\CCKTool\Configs\Default\Workspace\Autorun
\install.txt

2. Make a copy of this file and save here:

installation_directory\CCKTool\Configs\my_config\Workspace\Autor
un\install.txt

Open the install.txt document using a standard text editor, such as 
WordPad.

3. Edit the install.txt document and save your changes.

Your background bitmap image is now ready to specify when you run the CCK 
tool.



Checklist for Customize the CD Autorun Screen

Chapter 8 Preparing to Customize the CD Autorun Screen 89

Checklist for Customize the CD Autorun Screen
The Customize the CD autorun screen specifies the following:

• Background bitmap image (stored as 
Workspace\Autorun\Shell\bmps\install.bmp)

• Title bar text

❍ text that appears after “Netscape by” in the title bar

❍ text displayed just below the title bar

• Custom installation text file (stored as Workspace\Autorun\install.txt)
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Chapter 9

Preparing to Create the Installer

The final screen presented by the CCK tool, called Create the Installer, allows you 
to specify which Netscape components you want your installer to install. You can 
also use this screen to specify up to two additional installers to include with your 
customized Netscape installation package.

This chapter describes the Netscape components you can choose from and the 
requirements for additional installers you may wish to create.

This chapter contains these sections:

Selecting Netscape Components
Providing Additional Installers
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Selecting Netscape Components
Table 9-1 lists the optional components that you can include (or exclude) for your 
customized Netscape installer. Note that Mac OS components are pre-set; CCK 
doesn’t enable you to change the components included for Macintosh systems.

Netscape Navigator is always installed. If you choose not to include any additional 
components, your Netscape installer will install Netscape Navigator only. 

Table 9-1 Optional components you can include in your Netscape installer

Component Description Windows Linux Macintosh
(Not editable)

Sun Java 2 Enables Java in Netscape Yes Yes Yes

Mail & Instant 
Messaging

Email and newsgroup software and 
Instant Messenger services

Yes Yes Yes

Quality Feedback 
Agent

Tool for providing feedback to Netscape Yes Yes Yes

Spell Checker For use with Mail & News and Composer Yes Yes Yes

AOL ART 
Extensions

AOL ART image format support Yes No Yes

Net2Phone Internet phone dialer Yes No No

Macromedia Flash 
Player

Plug-in to view Macromedia 
Flash-enabled web pages

Yes Yes Yes

AOL On Desktop AOL subscription offering Yes No No

RealPlayer 8 Plug-in for playing music and video Yes No Yes

Viewpoint Media 
Player

Yes No No

Winamp Winamp media player Yes No No

HP Printer 
Identifier Plug-in

Plug-in for HP Printer support Yes No No

Classic skin Support for Netscape Classic theme Yes Yes No

Canadian region 
pack
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Providing Additional Installers
You can include installers for up to two additional products in your Netscape 
installer. When the user installs the recommended Netscape configuration, the 
additional installers are automatically installed after the main Netscape installation 
completes. However, if the user chooses the Custom path when installing 
Netscape, the user can choose not to install the additional components.

Each installer must consist of a single, self-extracting executable (.exe) file, such as 
those created by installation creation programs such as InstallShield from 
InstallShield Software Corporation. Before you run the CCK tool, place your 
installers here for convenience:

installation_directory\CCKTool\Configs\my_config\Workspace\CustInst\

You specify a path to the additional installers in the last screen presented by the 
CCK tool: "Create the Installer." 

Important: When you specify the size in kilobytes of each installer, Netscape 
recommends that you enter a number approximately three times the size of the 
actual installer .exe file, to ensure that the installer has enough room to expand 
and install the program on the user’s hard disk.
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Chapter 10

Verifying Your CCK Tool
Customizations

After you run the CCK tool, you should install your customized version of 
Netscape 7.0 and verify that your customizations have taken effect correctly. If you 
want to make any adjustments, you can run the CCK tool again and produce a 
modified installer in the same output directory.

Important: Verify and finalize your CCK tool customizations before you make any 
manual customizations. If you have to run the CCK tool again after making manual 
customizations to your installation files, the tool will erase all your manual 
customizations.

This chapter contains these sections:

Installing Your Customized Build
Verifying Your Browser Customizations
Verifying Your Mail and News Customizations
Verifying Your Installer Customizations
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Installing Your Customized Build
After the CCK tool has generated your custom installer, follow these steps to install 
your customized build:

1. On Windows, open the directory

installation_directory\CCKTool\Configs\Output\my_config\ 

and double-click the file setup.exe. 

On Linux, transfer the tar file from 

CCKTool\Configs\my_config\output 

to a Linux system, extract the contents, and change the permission of the file 
netscape-installer-bin to include executable permission. You can then run 
the install script by typing ./netscape-installer.

2. If you decided to include a CD autorun screen with your installer, verify that it 
appears and that it reflects any customizations you made with the CCK tool.

3. If you have a preexisting profile installed, create a new profile for testing 
purposes. To do so, click Manage Profiles when the Profile Manager appears, 
then click Create Profile.

You must test with a new, unmodified profile to verify that your 
customizations have taken effect.

Verifying Your Browser Customizations
While running a new, unmodified Netscape profile, verify the following:

• The Windows Start menu includes your customizations to the Netscape 
Program Folder.

• The Help menu includes the menu item that you specified and the new menu 
item points to the URL you specified.

• The Bookmarks menu and Personal Toolbar include your customizations.

• The Navigator browser's home page and Home button are set to the URL you 
specified.

• Your customized title bar text appears in the browser window's title bar.
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• Your customized animated logo (static and animated versions) appears in 
place of the Netscape logo, and clicking the animated logo button brings you to 
the URL you specified.

• Changes you made to the sidebar appear when you first launch Netscape.

• Changes you made to your proxy settings.

Verifying Your Mail and News Customizations
While running a new, unmodified Netscape profile, follow these steps to verify 
your Mail & Newsgroups customizations: 

1. Open the Window menu and choose Mail & Newsgroups. 

The first New Account Setup screen appears. Verify that the Mail and 
Newsgroup provider name that you specified with the CCK Tool show up 
correctly.

2. Select your customized mail account and click Next.

The second New Account Setup screen appears. Verify that the domain name 
you specified for the mail account shows up correctly.

3. Click Finish.

Verify that the display name you specified for new mail accounts shows up 
correctly.

4. Open the Edit menu and choose Mail & Newsgroups Account Settings.

Click the name of the new mail account and examine the settings, then do the 
same for Server and Outgoing Server. Verify that the domain name, display 
name, account name, and server settings that you specified with the CCK tool 
all show up correctly.

5. Click New Account and follow steps 1 through 4, except this time set up a new 
newsgroup account and checking the corresponding customizations.
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Verifying Your Installer Customizations
While running any Netscape profile, verify that only the components you selected 
in the final screen of the CCK tool are available. At a minimum, you should 
perform the checks described here as appropriate for each platform. See Table 9-1 
(page 92) for details on platform support for each component.

Verify the presence of the optional components you selected as follows:

Table 10-1

Component Verification

Sun Java 2 On Windows, open the Start menu, choose Settings, then 
Control Panel. Double-click Add/Remove Programs. You 
should see an entry for Java 2 (jre1.4.1) if it is installed.

Alternatively, in Netscape 7.0, open the Help menu and 
choose About Plug-ins. You should see Java plug-ins listed 
there.

Mail Open the Window menu and choose Mail & News. If you are 
running a profile for the first time, the Account Wizard 
should launch and guide you through the steps involved in 
setting up a new account. 

Netscape Instant 
Messenger

Open the Window menu and choose Instant Messenger. If 
you are running a profile for the first time, you should be 
guided through the steps involved in setting up an IM 
account.

Quality Feedback Agent If you left this option selected, you may discover during 
verification that it's not present. This is because the agent will 
be installed only 20% of the time when it has been selected on 
the final CCK screen. This is done deliberately to reduce the 
download size for 80% of installers, while still providing 
Netscape with statistically significant feedback.

Spell Checker Open the Window menu, choose Composer, and enter some 
lines of text. Then open the Edit menu and choose Check 
Spelling. The spell checker should appear.

AOL ART Extensions Open the directory in which Netscape 7.0 was installed, then 
open the Components directory. If the file nsart.dll is 
present, AOL ART extensions are installed.

Net2Phone Confirm that desktop icon is present.

Macromedia Flash 
Player

Choose About Plug-ins from the Help menu and confirm that 
the Flash plug-in is present. 
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RealPlayer 8 Choose About Plug-ins from the Help menu and confirm that 
the RealPlayer plug-in is present.

Winamp Open the Start menu, choose Settings, then Control Panel. 
Double-click Add/Remove Programs. You should see an 
entry for Winamp if it is installed.

In addition, when Winamp is installed, its icon appears on the 
desktop

HP Printer Identifier 
Plug-in

Open the Help menu, choose About Plug-ins, and confirm 
that the HP Peripheral Interrogator plug-in is present.

Classic skin Open the View menu, choose Apply Themes, and confirm 
that the Classic theme appears in the submenu.

Table 10-1

Component Verification
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Chapter 11

Manually Customizing the CD
Autorun Screen

The CD autorun screen automatically appears when a user inserts a customized 
Netscape CD into a CD-ROM drive. The standard CD autorun screen lets your 
users easily install Netscape or read installation instructions before they begin 
installation. You can customize some aspects of this screen, such as the title bar text 
and background, using the CCK tool.

If you’re planning to distribute a Netscape installer on a CD, you might want to 
make more customizations to the standard CD autorun screen than the CCK tool 
can implement. This chapter describes the manual customizations to the CD 
autorun screen that you can make, if you wish, to the installation files generated by 
the CCK tool.

This chapter contains these sections:

Why Manually Customize the Standard CD Autorun Screen?
Run The CCK Tool First
About the CD Autorun Files
Tools for Customizing the Standard Autorun Screen
Creating a CD Staging Area on Your Hard Disk
Understanding the rshell.ini File
Editing the rshell.ini File
Verifying Your CD Autorun Screen Manual Customizations
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Why Manually Customize the Standard CD 
Autorun Screen?

Chapter 8, “Preparing to Customize the CD Autorun Screen” (page 83), describes 
the following customizations that you can make to the standard CD autorun screen 
using the CCK tool:

• Customize the CD autorun screen’s background bitmap image.

• Provide your own title bar text and text below the title bar.

• Customize the contents of the installation guide text file.

You can manually customize the standard CD autorun screen if you want to:

• Create additional screens that inform users about your products, services, and 
promotions.

• Include additional files or software on the CD. You can add new screens and 
buttons to the CD autorun screen that give users easy access to the directories 
on the CD that contain these files, so that users don’t have to browse through 
the directories on the CD to find them. You can also include a button in the CD 
autorun screen that opens a readme.txt file, so users have easy access to 
information about these additional files. (For information about adding up to 
two additional installers with the CCK tool, see Chapter 9, “Preparing to 
Create the Installer” (page 91).

• Installers for additional applications on the CD. You can add buttons and text 
to the standard CD autorun screen that inform users about these applications 
and make them convenient to install.

Run The CCK Tool First
Before manually customizing the standard CD autorun screen, use the CCK tool to 
create a Netscape installer that includes the CD autorun screen. Make sure you 
select the checkbox labeled “Include CD autorun screen” on the Gathering 
Information screen. Checking this box causes CCK to include the files associated 
with the CD autorun screen when it creates your customized Netscape installer. 
After the CCK tool builds the installer, verify that the CD autorun customizations 
are correct.
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About the CD Autorun Files
The CD autorun screen is a standard Windows executable program that 
automatically launches when users insert the CD in a CD-ROM drive.

When you create your customized Netscape installer, the CCK tool places the CD 
Autorun files in this location:

installation_directory\CCKTool\Configs\my_config\Output

When you are finished editing the CD autorun screen files, you use the contents of 
the Output directory to create your CD layout. 

These files and directories are associated with the CD autorun screen:

• The Nsetup32.exe program (the Autorun program) and the rshell.ini file 
are both located in the directory Output\Shell\Nsetup32\. The rshell.ini 
file contains all of the custom settings and flags that control the appearance 
and function of the CD autorun screen.

• setup.exe, launch.ini, and autorun.inf are located in the Output directory, 
which is the root of the CD layout. They control the automatic launch of the 
Autorun program and the CD autorun screen. The launch.ini file points to 
the location of the Nsetup32.exe autorun program and its associated file, 
rshell.ini. If the Autorun screen doesn't automatically launch, users can 
double-click the setup.exe file.

In addition to controlling the appearance of the CD autorun screen, the 
rshell.ini file also links any number of CD autorun screens together using 
buttons. The buttons can also point to any installers or files included on your CD 
that you want users to be able to access.

For more information about preparing your CD layout, see Chapter 14, 
“Distributing Your Installers” (page 135).

Tools for Customizing the Standard Autorun 
Screen

To customize the standard autorun screen or add new screens, you’ll need:

• Aa standard text editor for editing the rshell.ini file.

• A graphics editing program, for creating any custom bitmap images that you 
want to include as background or button images in the Autorun screens.
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You can include one or more directories inside the shell directory to store the 
custom bitmap images used by the autorun screens. Depending on the CD layout 
you want to create, you can also include directories for additional items such as 
applications that you want users to be able to install by clicking buttons in the CD 
autorun screen.

Creating a CD Staging Area on Your Hard Disk
Before you start editing the rshell.ini file, you’ll need to determine the directory 
structure on the CD so that you know how to specify the pathnames of files that 
you want to be accessible through the Autorun screens. You do this by creating a 
staging area on your hard disk that exactly represents the final CD layout you 
intend to use.

To create a CD staging area:

1. Create a directory called Staging on your hard disk.

2. Locate the Output directory you created using the CCK tool.

3. Copy the contents of the Output directory into the Staging directory.

4. Inside the Staging directory, create a directory for each additional component 
that you want to include on the CD.

Inside the Staging\Shell directory, you’ll find a directory called bmps in which 
you’ll store the custom background bitmap images for any new CD autorun 
screens you create.

Understanding the rshell.ini File
Note: The rshell.ini file does not support the usage of double-byte character sets 
such as those used in the Chinese, Japanese, and Korean languages.

To understand the structure of the rshell.ini file, use a standard text editor such 
as NotePad to open Shell\Nsetup32\rshell.ini, and examine the descriptions 
contained in the file.

The rshell.ini file consists of two sections:

• The [General] section is where you specify the attributes of the control buttons 
(Browse CD, Back, and Exit) that appear at the bottom of the Autorun screens.



Understanding the rshell.ini File

Chapter 11 Manually Customizing the CD Autorun Screen 105

• The [Dialog] sections specify the attributes and behavior of each Autorun 
screen. Each [Dialog] section defines one Autorun screen, and you name the 
[Dialog] sections sequentially as [Dialog1], [Dialog2], [Dialog3], and so on, one 
for each Autorun screen.

General Settings in the rshell.ini File
This section describes the general settings in the rshell.ini file that apply to all 
dialogs.

Text for Browse, Back, and Exit Buttons
browse_button_text=text

back_button_text=text

exit_button_text=text

Specify the text displayed for the Browse, Back and Exit buttons. The Browse and 
Exit buttons appear on all dialogs. The Back button only appears if the rshell.ini 
file specifies more than one dialog.

Use an & (ampersand) in front of the character you want to assign as the keyboard 
shortcut for this button. For example, browse_button_text=Browse &CD sets C as 
the keyboard shortcut for this button.

Default Values

browse_button_text=Browse &CD

back_button_text=Back

exit_ button_text=Exit

Positions of Browse, Back, and Exit Buttons
browse_button_pos= x1,y1,x2,y2

back_button_pos= x1,y1,x2,y2

exit_button_pos= x1,y1,x2,y2

Specifies the position of the Browse, Back, and Exit buttons, relative to the top left 
corner (0,0) of the dialog. If not specified, button position is based on dialog size.
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Values

x1,y1: The upper left coordinates of the button, in pixels, relative to the top left 
corner of the dialog.

x2,y2: The lower right coordinates of the button, in pixels, relative to the top left 
corner of the dialog. These coordinates are ignored if button bitmap files are 
specified using the browse_button_bitmaps, back_button_bitmaps, or 
exit_button_bitmaps setting.

Bitmaps for the Browse, Back, and Exit Buttons
browse_button_bitmaps=up.bmp,dn.bmp,sel.bmp,dis.bmp

back_button_bitmaps=up.bmp,dn.bmp,sel.bmp,dis.bmp

exit_button_bitmaps=up.bmp,dn.bmp,sel.bmp,dis.bmp

Specifies the button bitmaps used for the Browse, Back, and Exit buttons. Four 
bitmaps specify the four possible states of the button: up, down, selected, disabled. 
This setting is optional. If you don't specify bitmaps for a button, the dialog uses a 
standard Windows button with the text specified in browse_button_text, 
back_button_text, or exit_button_text.

Values

up.bmp: Specifies the bitmap associated with the up (unpressed) button state.

dn.bmp: Specifies the bitmap associated with the down (pressed) button state.

sel.bmp (optional): Specifies the bitmap associated with the selected (mouse-over) 
button state.

dis.bmp (optional): Specifies the bitmap associated with the disabled button state.

Dialog Settings
This section describes the global settings that apply within a dialog.

Caption Text
caption=caption text

Specifies the text that appears in the dialog’s title bar.
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Dialog Position
dialog_position=x1,y1,x2,y2

Specifies the position of the dialog on the monitor screen. If not specified, the 
dialog is displayed at the center of the monitor screen. If bk_bitmap is specified, 
x2,y2 is ignored.

Values

x1,y1: Specifies the coordinates, in pixels, relative to the top left corner (0,0) of the 
dialog.

x2,y2: Specifies the coordinates, in pixels, of the lower-right corner of the dialog.

Background Bitmap
bk_bitmap=background.bmp

Specifies the background bitmap file used for the dialog. If a background bitmap 
file is not specified, the dialog uses the system background color for its background 
color.

Button Gap
button_gap=y

Specifies the vertical gap (y), in pixels, between the buttons in the dialog.

Global Text Settings
This section describes the settings used for the title text in a dialog. You use these 
settings to include a line or paragraph of text that can appear anywhere within the 
dialog.

Dialog Title Text
dialog_title_text=text

Specifies the title text for the dialog.

Dialog Title Position
dialog_title_pos=x1,y1,x2,y2

Specifies the position in pixels, relative to the top left corner of the dialog, of the 
title text.
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Values

x1,y1: Specifies the position of the top left corner of the text.

x2,y2: Specifies the position of the bottom right corner of the text.

Dialog Title Text Color
dialog_title_text_color=red,green,blue

dialog_title_shadow_color=red,green,blue

dialog_title_shadow_depth=red,green,blue

Specifies the text color, shadow color, and shadow depth of the dialog title text. 
You specify a number between 0 (black) and 255 (white) for each of the red, green, 
and blue values to get the overall pixel color.

Table 1 lists commonly-used colors from the standard Windows palette.

Table 11-1 Windows palette colors

Color Red,Green,Blue values

Black 0,0,0

White 255,255,255

Red 255,0,0

Green 0,255,0

Blue  0,0,255

Yellow 255,255,0

Magenta 255,0,255

Cyan 0,255,255

Dark red 128,0,0

Dark green 0,128,0

Dark blue 0,0,128

Dark cyan 0,128,128

Dark gray 128,128,128

Dark magenta 128,0,128

Gray 192,192,192
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Dialog Title Text Font
dialog_title_text_font=font,size

Specifies the font and font size used for the dialog’s title text. It’s best to use a 
standard font that you know will be available on end users’ machines. If not 
specified, the system font and font size are used.

Dialog Title Text Style
dialog_title_font_bold=TRUE/FALSE

dialog_title_font_underline=TRUE/FALSE

dialog_title_font_italic=TRUE/FALSE

If set to TRUE, specifies the font style (bold, italic, underline) used for the dialog’s 
title text. If not specified or if set to FALSE, the style is not applied.

Global Button Text Settings
This section describes the text settings used for all button text in a dialog.

Text Colors
text_color_default=red,green,blue

text_color_highlight=red,green,blue

Specifies the default text color and the mouse-over (highlight) text color of all 
button text in a dialog. You specify a number between 0 (black) and 255 (white) for 
each of the red, green, and blue values to get the overall pixel color. The text 
automatically changes to the mouse-over (highlight) text color when you position 
the mouse over a button in the dialog.

Table 11-1 lists commonly used colors from the standard Windows palette.

Button Title and Body Text
button_title_text_font=font,size

body_text_font=font,size

Specifies the font and size used for the dialog’s button title text and button body 
text. It’s best to use a standard font that you know will be available on end users’ 
machines. If not specified, the system font and font size are used.
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Button Title Font
button_title_font_bold=TRUE/FALSE

button_title_font_italic=TRUE/FALSE

button_title_font_underline=TRUE/FALSE

If set to TRUE, specifies the font style (bold, italic, underline) used for the dialog’s 
button title text. If not specified or if set to FALSE, the style is not applied.

Button Body Text Style
body_text_font_bold=TRUE/FALSE

body_text_font_italic=TRUE/FALSE

body_text_font_underline=TRUE/FALSE

Specifies the font style (bold, italic, underline) used for the dialog’s button body 
text. If not specified or set to FALSE, the style is not applied.

Column Settings Within a Dialog
This section describes the settings used for columns within a dialog. Each dialog 
can have one or more columns. The settings for the first (left-most) column all 
begin with col1; the settings for the second column all begin with col2, etc. If you 
only want one column of buttons in a dialog, delete all of the col2 and greater 
settings, or you can leave them blank.

Position of First Button in Column One
col1_button_pos=x,y

Specifies the position of the first button in column 1 of a dialog. You specify the x,y 
coordinates of the upper-left corner of the button, relative to the upper-left corner 
of the dialog (0,0). If you want, you can specify an offset position for an individual 
button using the button1_offset setting described later in this chapter.

Position of a Button’s Descriptive Text
col1_text_offset=offset

col1_text_posx=x
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You can use either of these settings to specify the position of the button’s 
descriptive text. Use col1_text_offset if you want to specify the text’s position 
by defining an offset between the button and the button text. Use col1_text_posx 
instead if you want to specify the absolute x position of the button’s descriptive 
text.

If unspecified, the default is col1_text_offset=10. If both settings are specified, 
col1_text_offset is ignored and the absolute x position as specified in 
col1_text_posx is used.

Column Text Width
col1_text_width=x

Specifies the distance x, relative to the left edge of the dialog box, at which the 
button descriptive text wordwraps to the next line. If this setting is not specified, 
the text wordwraps when it is 10 pixels to the left of the right edge of the dialog.

Button Settings Within a Dialog
This section describes the settings used for buttons within a dialog. Each dialog can 
have one or more buttons. The settings for the first button all begin with button1, 
the settings for the second button all begin with button2, and so on. If you only 
want one button in a dialog, delete all of the button2 and greater settings, or leave 
them blank.

Button Bitmaps
button1_bitmaps= up.bmp,dn.bmp,sel.bmp,dis.bmp

Specifies the button bitmaps used for button1. Four bitmaps specify the four 
possible states of the button: up, down, selected, disabled. This setting is optional. 
If you don't specify bitmaps for a button, the dialog uses a standard Windows 
button with the text specified in button1_text_title.

Values

up.bmp: Specifies the bitmap associated with the up (unpressed) button state.

dn.bmp: Specifies the bitmap associated with the down (pressed) button state.

sel.bmp (optional): Specifies the bitmap associated with the selected (mouse-over) 
button state.

dis.bmp (optional): Specifies the bitmap associated with the disabled button state.
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Button Action
button1_cmdline=action,target

Specifies the action you want to assign to the button. Clicking a button can cause 
one of seven possible actions, depending on the value you specify for the action 
argument. The possible button actions and arguments are:

• Launch a program (action=exe)

button1_cmdline=exe,path to executable file

Example: button1_cmdline=exe,..\..\Netscape\setup.exe

• Go to a different dialog screen (action=window)

button1_cmdline=window,dialog#

Example: button1_cmdline=window,dialog2

• Open a file (action=open)

button1_cmdline=open, path to file

The file opens with whatever program the operating system has associated 
with the file’s type. If a file type association doesn’t exist, Windows asks the 
user to choose a program.

Example: button1_cmdline=open,..\..\install.txt

• Print a file (action=print)

button1_cmdline=print, path to file

The file is printed with whatever program the operating system has associated 
with the file’s type. If a file type association doesn’t exist, Windows asks the 
user to choose a program.

Note: You cannot print HTML files through Windows. 

Example: button1_cmdline=print,..\..\install.txt

• Explore a directory on the CD (action=explore)

button1_cmdline=explore,directorypath

Opens the specified directory on the CD. The directory path must be specified 
as an absolute path from the root of the CD.

Example: button1_cmdline=explore,extras\clipart opens the 
extras\clipart directory, which is at the root level of the CD.

• Open a file in Netscape Navigator (action=netscape)
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button1_cmdline=netscape, path to file

Opens the specified file using the currently-installed version of Netscape 
Navigator. The file type can be .html, .gif, .jpeg, or any other file type that 
the browser can open, such as .pdf (if the correct plug-in is already installed).

Example: button1_cmdline=netscape,myfile.html

• Create a shortcut on the desktop (action=desktop)

button1_cmdline=desktop, file or directory name, shortcut name, 
path to icon file

When button1 is clicked, a shortcut is created on the desktop, using the 
specified shortcut name and icon file, that opens the specified file or directory 
on the CD. File or directory paths must be specified as absolute paths from the 
root of the CD.

Example: button1_cmdline=desktop,readme.txt,Read 
Me,\shell\icons\readme.ico

Button Text

button1_text_title=text

button1_text_body=text

Specifies the button title text and body text for button1.

Button Offset
button1_offset=x,y

Specifies the button's horizontal (x) and vertical (y) offset, in pixels, from the 
location specified in the col1_button_pos setting. If there is more than one button 
in column 1, and you only specify an offset for button1, the other buttons in the 
same column will use the same vertical (y) offset. You can change the offsets for the 
other buttons by specifying individual button offsets for each of them.

Editing the rshell.ini File
To edit the rshell.ini file:

1. Locate the Staging\Shell\nsetup32\rshell.ini file and open it using a 
standard text editor. Familiarize yourself with the settings in the rshell.ini 
file.
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2. Decide how many dialog screens you want to use. If you need more dialog 
screens than are defined in the rshell.ini file, copy an entire [Dialogx] 
section (where x is a unique number associated with each dialog) and paste it 
as needed into the file. Each dialog screen must have a unique number. If you 
need fewer than are provided by default, remove entire [Dialogx] sections as 
necessary.

3. Design the layout, background images, buttons, and text for each dialog 
screen. Make the necessary customizations in the settings in the rshell.ini file.

Note: Rather than entering the text for a screen in the rshell.ini file, you may 
prefer to create your text as part of the background image using an image 
editing program such as Adobe Photoshop. Using an image editing program 
gives you more control over the appearance of the text, including fonts and 
colors.

4. Assign an action to each button in each dialog screen.

5. Save your changes to the rshell.ini file in place; do not move the file.

Adding a New Screen
The supplied rshell.ini file includes a second dialog, Dialog2, that is not visible 
by default. To enable it, locate the button3 settings that are commented out with 
semicolons (located within the section in the rshell.ini file called "Buttons 2 - 6 
for Dialog 1"). Remove the semicolons in front of all the button3 settings, save your 
changes, and then launch the Autorun screen by double-clicking the file 
Shell\nsetup32\Nsetup32.exe file. Click the third button in the first screen 
(labeled Bonus Applications and Plug-ins) and you'll be able to see the second 
dialog.

To add a new Autorun screen:

1. Locate the file Staging\Shell\nsetup32\rshell.ini file and open it using a 
text editor.

2. Copy an entire [Dialogx] section and paste it into the rshell.ini file at the 
location where you want the new screen to appear.

3. Increment the value of x in the [Dialogx] identifier, so that the [Dialogx] 
section has a unique number. Each [Dialogx] section must have a unique 
number associated with it, such as[Dialogx], [Dialogx], [Dialogx].

4. Make the necessary customizations to each [Dialogx] section.

5. Save your changes to the rshell.ini file in place; do not move the file.
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Adding a Background Image to a Dialog Screen
If you don't specify a background image for a new screen, the new screen uses the 
system background color. To add a background image to a new screen, follow 
these steps:

1. Using a graphic editing program, create a background bitmap that's 640 x 480 
pixels, and save it as a .BMP format file in the shell\bmps\ directory.

Keep the following in mind:

❍ Keep your bitmap file sizes as small as possible by reducing the number of 
colors the images use or by removing (flattening) the layers if you created 
the images in Adobe Photoshop. If your images are too large, you may not 
be able to see them in the Autorun screen. If you cannot see a background 
image when you test the Autorun screen, open the image in a paint 
program and try reducing the number of colors to reduce the image's file 
size.

❍ To prevent palette-swapping when switching between Autorun screens, be 
sure to use a 256-color palette in each background image you create.
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❍ Be sure to leave room at the bottom of the background bitmap (about 40 
pixels in height, preferably black) for placement of the control buttons 
(Browse CD, Back, and Exit) specified in the rshell.ini file.

For example, here is an illustration of the background bitmap image used 
to create the standard Autorun screen. Note that a black area 40 pixels high 
was created at the bottom of the image, to allow placement of the control 
buttons.

2. Open the rshell.ini file using a text editor.

3. Locate the dialog section that you want to customize.

4. To the right of the bk_bitmap= setting, enter the path to the bitmap file, 
relative to the location of the shell directory. For example:

bk_bitmap=..\bmp\myinstall.bmp

5. Save your changes to the rshell.ini file in place; do not move the file.
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Customizing a Screen's Title Bar Text
The title bar appears at the top of every autorun dialog screen. You may want to 
include your company’s name in the title bar or provide other identifying 
information. For example, this screen shows customized text in a CD autorun 
screen’s title bar:

To customize a screen’s title bar:

1. Open the rshell.ini file using a text editor.

2. Locate the [Dialogx] section that you want to customize.

3. To the right of the caption= setting, enter the text that you want to appear 
in the screen's title bar.

For example, the text "Mach Networks" results in the title "Netscape by Mach 
Networks"

caption=Mach Networks

4. Save your changes to the rshell.ini file in place; do not move the file.
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Adding a New Button to a Screen
You can add a button to an autorun screen that performs any of these functions:

• Launch an executable (.exe) program.

For example, if you want to include an installer for another application on the 
CD, you can add a button that users can click to launch the installer.

• Go to another screen

For example, if you’re creating multiple CD autorun screens, you can add a 
button that users can click to go to a particular screen. (This is in addition to the 
standard Browse, Back, and Exit buttons that appear on each autorun screen.)

• Open a file

For example, you can add a button that opens a readme.txt file so that users 
can read installation instructions for another application you’re providing on 
the CD.

• Print a text file

For example, you can add a button that prints the installation instructions.

• Explore a directory

For example, if you’re including a directory of utilities on the CD, you can add 
a button that opens that directory so that user can view its contents.

• Open a file in Netscape Navigator

For example, if you’ve provided an HTML or GIF format file on the CD that 
you want users to view in Navigator, you can add a button that opens the file 
using an already-installed version of Navigator.

• Create a shortcut on the user’s desktop

For example, if there’s a directory on the CD that you want users to have easy 
access to, you can create a desktop shortcut for that directory.

To add a new button to an Autorun dialog screen:

1. Open the rshell.ini file using a text editor.

2. Locate the dialog section where you want to add a new button.

3. Within the dialog section, locate the section where the buttons for the dialog 
are defined. Each button group begins with 

button1_bitmaps=
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4. Decide how many buttons you want to appear in the dialog.

5. If you need more buttons than are defined by default in the rshell.ini file, 
copy and paste new button groups and increment the button number for each 
new group you add.

6. To remove buttons, delete the button groups that are above the number you 
need, or simply leave their settings blank.

7. Assign an action to each button using the buttonx_cmdline= setting. You can 
define any one of seven different button actions. See the description of the 
buttonx_cmdline= setting earlier in this chapter, or by referring to the 
comments in the rshell.ini file.

For example, to have button1 go to the dialog2 screen, you would enter:

button1_cmdline=window,dialog2

For example, to have button1 launch a program named Setup.exe, you would 
enter:

button1_cmdline=exe,..\..\Netscape\Setup.exe

8. When you have finished defining buttons and button actions, save your 
changes to the rshell.ini file.

Verifying Your CD Autorun Screen Manual 
Customizations

After you finish editing the rshell.ini file, you should view your custom 
Autorun screens so you can verify your customizations. Follow these steps:

1. Locate this directory:

intallation_directory\CCKTool\Configs\my_config\Output\Shell\

2. To test the CD autorun screens, launch the first screen by double-clicking the 
file \Shell\Nsetup32\Nsetup32.exe.

3. Verify the appearance of your CD autorun screen and test the action of each 
button.
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Chapter 12

Advanced Netscape Customizations

After you've run the CCK tool, produced an installer, and made any manual 
customizations you may require for the CD autorun screen, you can perform 
additional manual customizations before distributing the installer to your users. 
This chapter provides an overview of the preferences architecture and the general 
procedure for manual customization. It also provides detailed, step-by-step 
instructions for some of the most common manual customizations.

This chapter contains these sections:

Understanding How Manual Customization Works
Understanding the Preferences Architecture
Before You Start
Editing a Configuration File with a Text Editor
Instructions for Common Manual Customizations

Understanding How Manual Customization 
Works

Netscape is shipped with many preferences and user-interface items preset as 
“factory defaults.” After Netscape is installed, these settings are stored in special 
Javascript files called configuration files.

You can edit configuration files to customize the default settings for your users. For 
example, you can manually customize:

• Whether the Netscape activation screen launches at startup

• The Welcome page that appears at startup

• Any items that appear in the Help menu in Netscape (both text and URLs)
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• Password requirements, such as whether an email password is remembered or 
needed for each session

To create a customized Netscape installer by using a combination of the CCK tool 
and manual customizations, you follow this general procedure:

1. Complete all customizations that can be performed with the CCK tool and use 
the tool to build the installer. The installation files will be located in the 
directory

CCKTool\Configs\configuration_name\Output\

where configuration_name is the configuration name you specified (or selected) 
for your customized configuration in the first screen of the CCK tool.

2. Verify your customizations and run the CCK tool again, if necessary, to adjust 
them.

3. Identify the preferences you want to change and the Javascript files that specify 
them. Table 1 below specifies the main Javascript files involved. Detailed 
information on specific preference entries within those files will be available 
online at a later time; see Netscape 7.0 Client Customization Kit Release Notes 
for the most current information.

4. Identify the xpi files in the installation files produced by the CCK Tool that 
contain the JavaScript files you want to change. (Table 1 below specifies the 
which xpi files contain which JavaScript files.)

5. For each xpi file involved:

❍ Use a utility such as WinZip to extract the entire xpi file into some 
convenient temporary directory.

❍ Locate the JavaScript files that you want to modify in the extracted files.

❍ Use a text editor to modify the JavaScript files.

❍ Use a utility such as WinZip to zip up all the files you extracted from the 
xpi, including the ones you modified.

❍ Replace the old xpi file with your new xpi file.

6. After you have modified the necessary JavaScript files and replaced the old xpi 
files with the revised xpi files, run the installer and test the resulting Netscape 
installation to ensure that your customizations have taken effect.
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For step-by-step instructions describing this procedure more precisely for specific 
manual customizations, see single change to a JavaScript file, see Instructions for 
Common Manual Customizations (page 126).

Understanding the Preferences Architecture
Factory defaults are set in .js files, which are in turn located in zipped .xpi files in 
the directory 

CCKTool\Configs\my_config\Output\Core

The primary .js file is all-ns.js, which is located in the file browser.xpi.

Note: If you make changes to preferences stored (after installation) in the prefs.js 
file, where the user-configurable customizations are stored, you run the risk of 
overwriting the bookmarks, address books, and other settings that your users may 
have set in their existing profiles.

Table 12-1 JavaScript files to edit
Filename XPI file that contains 

preferences file
Contents

all-ns.js browser.xpi general preferences and 
those not covered 
specifically by other 
.js files

config.js browser.xpi chrome-related 
preferences

editor.js browser.xpi preferences related to 
composer

mailnews.js browser.xpi mail and news 
preferences

prefs.js The contents of prefs.js 
are created from the contents 
of the files all-ns.js and 
all.js in browser.xpi.

user-configurable 
customizations

security-prefs.js browser.xpi security preferences

Windows: winpref.js 

Unix/Linux: unix.js 

Macintosh: macprefs.js 

browser.xpi fonts for each platform



Understanding the Preferences Architecture

124 Guide to Customizing and Distributing Netscape 7.0 • August 2002

Setting a preference in one of the .js files will create a default value that can be 
changed by the user by choosing Preferences from the Edit menu. Not all 
preferences are initialized at startup via these .js files. In addition, some settings 
are stored in RDF files that live in the operating system's directory after the user 
installs Netscape. For example, for Windows NT, the path would be:

C:\Winnt\Profiles\user_name\Application 
Data\Mozilla\Profiles\profile_name\

Important Legal Restrictions
The license that ships with the CCK tool imposes restrictions on certain kinds of 
customizations. In particular, under the terms of the license agreement, you may 
NOT perform any of the following customizations:

• Remove the Search and Directory folder or the Inside Netscape folder from 
their default locations in the Bookmarks menu when you open a new profile 
with Netscape 7.0.

• Remove or modify the contents of the Search and Directory folder or the Inside 
Netscape folder in the Bookmarks menu.

• Change the Sidebar tab that is open by default when you open a new profile 
with Netscape 7.0 (currently the News tab).

• Remove the Search or Today’s Tips sidebar tabs from the My Sidebar tabs 
shown by default when you open a new profile with Netscape 7.0.

• Remove any of the Sidebar tabs from the list of tabs available to an end user in 
the default drop-down list of sidebar tabs available when you open a new 
profile with Netscape 7.0. (It's OK to add additional tabs).

• Change the default Search service to which the Location Bar Search button and 
other search services are linked.

• Change the page that opens by default when Mail starts up.
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Before You Start
The CCK tool allows you to customize specific aspects of the look and feel of 
Netscape. In addition, by editing all-ns.js and other configuration files, you can 
customize almost any aspect of Netscape. You'll need to familiarize yourself with 
the Netscape user interface and associated preferences to assess how to customize 
Netscape for your needs. You'll also need to identify:

• The configuration file (typically a JavaScript file) involved

• The name of the preference within that configuration file.

• The .xpi file where the configuration file is located in the installation files 
produced by the CCK tool.

More details about names of specific preferences and the configuration files where 
they are stored will be provided online. See the Netscape 7.0 Client Customization 
Kit Release Notes for the most current information 
(home.netscape.com/eng/mozilla/ns7/relnotes/cck.html). 

Some Netscape features or attributes are under user control, but only indirectly. 
Such features include whether certain toolbars are displayed, and also settings that 
Netscape remembers automatically, such as window size and position. Such 
settings are not “preferences” in the typical sense, because they cannot be set from 
a user-selected window or dialog box. Instead, these features are referred to as 
Netscape “states.”

In addition to the preferences that you can set, you can alter Netscape 
configuration settings that are not under direct or indirect user control, such as the 
items that appear in the Help menu.

Editing a Configuration File with a Text Editor
By editing all-ns.js and other configuration files directly, you can modify 
Netscape in a variety of ways. You should use a simple text editor (one that doesn't 
do any formatting) to modify a configuration file. For example, you can use 
NotePad for Windows, SimpleText for Mac OS, or vi for X-Motif. If you use a word 
processor to edit the configuration file, make sure you save the edited 
configuration file as plain (ASCII) text. If formatted characters are used, the 
configuration file may not be created correctly.
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As described above under Understanding How Manual Customization Works 
(page 121), once you have extracted the .js file that you want to modify from the 
xpi file, you can edit it with a text editor. To do so, you must determine the value 
type that the preference takes (numeric, string, or boolean) and make the required 
change to produce the default setting that you want. 

Important: Don't use Netscape Composer to edit configuration files. Composer 
adds characters to the file that can interfere with its use as a configuration file.

Instructions for Common Manual Customizations

Disabling Netscape Activation/Registration
If you customize mail and news settings, you may want to disable Netscape 
activation as described here before you distribute your installer. For a discussion of 
the effect of Netscape activation on customized mail and news settings, see 
Netscape Activation Considerations for Mail and News (page 78).

To turn off activation, follow these steps:

1. Locate the file 

CCKTool\Configs\my_config\Core\browser.xpi

2. Unzip the entire file browser.xpi into a convenient empty directory.

3. In the directory containing the extracted files, locate the file 
bin\defaults\pref\all-ns.js.

4. Open all-ns.js with a text editor.

5. Locate this line:

pref("browser.registration.enable", true);

6. Change true to false and save the file.

7. Zip up the entire bin directory again into a new file called browser.xpi.

8. Replace the original browser.xpi file in CCKTool\Configs\my_config\Core\ 
with the new browser.xpi.
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9. Test your customization.

To test whether activation has been successfully disabled, run setup.exe and 
launch Netscape with a new profile. (Activation runs only once per profile.) If 
the activation screen does not appear, activation has been disabled.
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Customizing the Welcome Page
The Welcome page appears when the user starts up a new profile for the first time. 
You may want to customize it so you can provide up-to-date information for new 
users when they first launch Netscape.

Follow these steps to manually customize the URL specified for the Welcome page:

1. Locate this file: 

CCKTool\Configs\my_config\Core\browser.xpi

2. Unzip the entire file browser.xpi into a convenient empty directory.

3. In the directory containing the extracted files, locate the file 
bin/defaults/pref/all-ns.js.

4. Open all-ns.js with a text editor.

5. Locate this line:

pref("browser.startup.homepage", 
"chrome://navigator-region/locale/region.properties");

6. Change the URL to the URL for your own welcome page and save the file.

7. Zip up the entire bin directory again into a new file called browser.xpi.

8. Replace the original browser.xpi file in CCKTool\Configs\my_config\Core\ 
with the new browser.xpi.

9. Test your customization.
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Chapter 13

Preparing Macintosh Installers and
Program Files

To create a customized Macintosh installer, you first create a customized Windows 
installer, then transfer the customized Windows files to a standard Macintosh 
installation package (for Mac OS 9) or an installed version of Netscape 7.0 (for Mac 
OS X). This chapter provides detailed instructions for this procedure.

Note: If you are preparing a Linux installer, you simply transfer the tar file 
generated by the CCK tool file to a Linux system for testing and distribution. For 
details, see Chapter 4, “Preparing Operating System, Language, and Installer 
Information” (page 61).

This chapter contains these sections:

Tools Required
Creating a Customized Macintosh Installer

Tools Required
To create a customized Netscape browser installer for Macintosh systems, you 
need these Macintosh tools:

• Stuffit Deluxe 5.5 or higher, which is available from your local computer store 
or through http://www.aladdinsys.com/store/

• ZipIt 1.3.8 or higher, shareware available through 
http://www.zdnet.com/downloads/

• Mac OS 9 diskcopy utility

• Macintosh system with both Mac OS 9 and Mac OS X installed 
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Creating a Customized Macintosh Installer
The first five steps involved in creating a customized Macintosh installer are 
common to both Mac OS 9 and Mac OS X: 

1. In the second screen of the CCK tool, “Specify Operating System and 
Language,” choose Mac OS in the drop down menu.

2. Continue through the rest of the CCK screens, customizing as you go. 

3. When you reach the Create Macintosh Installer screen, click the Build Installer 
button. CCK creates the file CustomizedMacFiles.zip in this directory: 

CCKTool\Configs\my_config\Output\

4. Transfer CustomizedMacFiles.zip to file to a system running Mac OS 9 and let 
it expand into these files (Note that StuffIt Expander creates a folder called 
CustomizedMacFiles that contains these files. If you use ZipIt, create a folder 
named CustomizedMacFiles and place these files in that folder.): 

❍ ChromeDefaults.zip -- contains chrome and defaults folder

❍ SMI_Creator_for_NSOSX.sit

❍ Resource_IO.sit

❍ ns_smi_eula.rsc.sit

At this point, the instructions differ depending which operating system you are 
running:

Create a Customized Mac OS 9 Installer (page 131)
Creating a Mac OS X Installer (page 133)
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Create a Customized Mac OS 9 Installer
After you complete steps 1 through 4 above under“Creating a Customized 
Macintosh Installer,” follow these steps to create a Mac OS 9 installer:

1. Go to http://home.netscape.com and download the Full Installer for the 
Mac OS 9 version of Netscape 7.0.

2. Locate the Installer Modules folder inside the Netscape 6 Full Installer 
(auto-expanded) folder.

3. Select browser.xpi, langenus.xpi, regus.xpi, and deflenus.xpi and 
extract the complete contents of these files.

4. Replace these files in browser.xpi from ChromeDefaults.zip: 

❍ /viewer/chrome/classic.jar from chrome:

❍ /viewer/chrome/modern.jar from chrome:

❍ viewer/defaults/pref/all-ns.js from defaults/pref

❍ viewer/defaults/pref/all.js from defaults/pref

5. Replace these files in langenus.xpi from ChromeDefaults.zip:

❍ viewer/chrome/en-US.jar from chrome/ 

6. Replace or add these files in regus.xpi from ChromeDefaults.zip:

❍ viewer/chrome/US.jar from chrome/ 

❍ viewer/defaults/profile/US/bookmark.html from 

defaults/profile/US/

❍ viewer/defaults/profile/US/panels.rdf from 

defaults/profile/US/

❍ viewer/defaults/profile/US/panels.rdf from 

defaults/profile/US/

❍ add to viewer/defaults/isp/US/panels.rdf from 

defaults/isp/US/mailaccount.rdf and newsacount.rdf (Unlike the 
other files, mailaccount.rdf and newsaccount.rdf are not part of 
the standard Macintosh installer.)

7. Replace or add these files in deflenus.xpi from ChromeDefaults.zip:

❍ viewer/defaults/profile/bookmark.html from defaults/profile/ 

❍ viewer/defaults/profile/panels.rdf from defaults/profile/
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❍ add to viewer/defaults/isp/ from 

defaults/isp/US/mailaccount.rdf and newsacount.rdf (Unlike the 
other files, mailaccount.rdf and newsaccount.rdf are not part of 
the standard Macintosh installer.)

8. Replace or add these files in To customize the Welcome Dialog or to add or 
subtract components, use a text editor to modify the file Config.ini.

9. Use the Stuffit utility to create a self-extracting archive from the Netscape 7.0 
Full Installer folder.

10. Verify the customization by expanding the executable, then install the build 
and check for the appropriate customizations.

If you are creating a network installer, use the self-extracting archive. Users will 
download this file, extract its contents, and run the Netscape 7.0 Installer file to 
install Netscape.

If you are creating a CD, use the Netscape 7.0 Full Installer directory for the 
contents of the Macintosh partition, not the self-extracting archive.
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Creating a Mac OS X Installer
After you complete steps 1 through 4 above under “Creating a Customized 
Macintosh Installer” (page 130), follow the steps in this section to create a Mac OS 
X installer. 

Note: You must perform steps 1 through 8 on Mac OS 9.

1. Go to home.netscape .com and download Netscape 7.0 for Mac OS X. When the 
download completes, a disk image folder named Netscape for Mac OS X 
appears on the desktop. 

2. Create a folder of your choice, for example Custom Netscape for Mac OS X. 

3. Drag the contents of the Netscape for Mac OS X folder to the folder you 
created. Arrage the folders so they appear the same as the disk image:

❍ “Netscape”

❍ “<- To install, just copy”

❍ “<- this folder to”

❍ “<- your hard disk”

4. Decompress ChromeDefaults.zip in CustomizedMacFiles folder. 
(Stuffit Expander creates a folder called ChromeDefaults. If you are using 
the ZipIt utility, you need to create the ChromeDefaults folder.). 
ChromeDefaults contains these two folders:

❍ chrome 

❍ defaults 

5. Locate netscape.app in the folder Custom Netscape for Mac OS X, then 
Ctrl-click the file. 

In the menu that appears, choose Show Package Contents. The folder opens.

6. In the Contents/MacOS directory, replace the chrome and defaults folders 
with the ones located in the in the ChromeDefaults folder.

7. In the folder CustomizedMacFiles, double-click these three .sit files to expand 
them:

❍ SMI_Creator_for_NS-OSX.sit

❍ Resource_IO.sit

❍ ns_smi_eula.rsrc.sit
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8. Drag the folder Custom Netscape for Mac OS X on to SMI Creator 
for Mac OS X to create an SMI installer, Custom Netscape for MacOS 
X.smi

9. Verify your customization by launching Netscape on Mac OS X and checking 
for the appropriate customizations.
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Chapter 14

Distributing Your Installers

Once you have generated and tested your customized installers, you need to 
prepare them for distribution. This chapter summarizes some of the major tasks 
involved.

This chapter contains these sections:

Distributing a CD-Based Installer
Distributing Network-Downloadable Installers or Binaries
End-User Instructions

Distributing a CD-Based Installer
The general process for distributing Netscape installers on CDs works like this:

1. Verify your CD layout.

2. Create the CD master disc.

3. Verify and virus check the CD master disc.

4. Create an archive copy of the CD master disc.

5. Deliver CD master disc for duplication.

6. Distribute CDs.

The sections that follow describe how to verify your CD layout and prepare your 
files for CD distribution.
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Verifying Your CD Layout (No Autorun Screen)
If you didn't include a CD autorun screen, verify the files for your CD layout as 
described below.

Windows CD Layout
Verify your CD layout for Windows as follows:

1. Open the directory 

installation_directory\CCKTool\Configs\my_config\Output\

Verify that it includes the following files:

❍ A file called Setup.exe, which is the Netscape installer file.

❍ A set of .xpi files, which contain the Netscape component files in archive 
format.

❍ autorun.inf, which automatically launches the Netscape installer 
setup.exe file when the user inserts the Netscape CD into a CD-ROM 
drive.

2. Remove the file called NSSetup.exe, because it's not needed. Users will 
double-click the setup.exe installer file to begin installation.

3. Go to “Preparing Your CD-Ready Files for CD Distribution” (page 139), later in 
this chapter.

Macintosh CD Layout
For Macintosh, you need to verify the contents of the Netscape Full Installer folder 
that you modified as described above under Building Macintosh Installers. It 
should contain the following files and directories:

• Netscape 7.0 Installer

• Netscape 7.0 read-me file

• License

• Installer Modules (folder that includes config.ini, installer.ini, and all 
the .xpi files)

After confirming that these files and directories, go to “Preparing Your CD-Ready 
Files for CD Distribution” (page 139).
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Linux CD Layout
After you run the CCK tool to create a Linux installer, decompress the Linux tar file 
located in this directory:

CCKTool\Configs\my_config\Output\

The decompressed files should look like this: 

• xpi directory

• config.ini 

• installer.ini 

• license.txt 

• netscape-installer 

• netscape-installer-bin 

• README 

After confirming that these files and directories, go to “Preparing Your CD-Ready 
Files for CD Distribution” (page 139).

Assembling Your CD Layout (Autorun Screen)
If you included a CD autorun screen for your Windows installer, assemble the files 
for your CD layout as follows:

1. Open the directory

installation_directory\CCKTool\Configs\my_config\Output\

Verify that the Output directory contains the following:

❍ A directory called Core, which contains the customized Netscape files

❍ A directory called Shell, containing the subdirectories \Bmps and 
\Nsetup32, which include the files for the CD autorun screen

❍ Autorun.inf (launches the setup.exe at the root of the CD image after 
the CD is inserted in the drive)

❍ Launch.ini (configures setup.exe and detects Windows operating 
system)
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❍ setup.exe (launches nsetup32.exe, which displays the first Autorun screen)

Your CD layout should follow the same general layout as the typical one 
illustrated here:

2. Verify that the Shell directory contains these files and folders:

❍ A folder called \Bmps, which contains all the standard and customized 
bitmap (.bmp) files used by the CD autorun screens

❍ A folder called \Nsetup32, which contains the following:

• Nsetup32.exe, the autorun program

• rshell.ini, the file that defines the appearance and behavior of the 
Autorun screens. See Chapter 11, “Manually Customizing the CD 
Autorun Screen” (page 101) for information on how to manually 
customize this file.

3. If you’ve manually customized the CD autorun screen so that users can install 
additional plug-ins or applications from the Autorun screens, create a 
directory called Xinstall inside the directory 

installation_directory\CCKTool\Configs\my_config\Output\Shell

Buttons you add to your CD autorun screens can be linked to the executable 
files you include in the Xinstall directory, so that users can install additional 
software simply by clicking a button.
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4. Put the additional installers into subdirectories inside the directory

installation_directory\CCKTool\Configs\my_config\Output\Shell 

Important: Make sure that the actual locations of the additional installers 
match the file pathnames you specified for them in the rshell.ini file.

5. If you’ve manually customized the CD autorun screen to open any other files, 
such as a readme.txt file, include the additional files inside the directory

installation_directory\CCKTool\Configs\my_config\Output\Shell

and make sure that their locations match the file pathnames you specified for 
them in the rshell.ini file.

Preparing Your CD-Ready Files for CD 
Distribution
To prepare your CD-ready files for CD distribution, you need the following:

• Software to create a data CD, such as Adaptec Easy CD Creator or Adaptec 
Toast

• CD recorder, for creating your master CD

• CD-recordable discs, available where you purchased your CD recorder

• Bit-compare program such as Microsoft’s WinDiff utility

• virus checker program

• CD duplication service, to make copies of your master CD

Follow these steps to create a master CD disc:

1. If you didn't include a CD Autorun Screen, verify the files in your CD layout as 
described in Verifying Your CD Layout (No Autorun Screen) (page 136). If you 
included a CD autorun screen, assemble the files for your CD layout as 
described in Assembling Your CD Layout (Autorun Screen) (page 137).
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2. Using your CD creation software, create a CD master disc that contains all the 
files from the directory

installation_directory\CCKTool\Configs\my_config\Output\ 

If you are creating a hybrid CD that includes a Macintosh partition, you also 
need to specify the location of the Netscape Full Installer folder that you 
modified as described in Chapter 13, “Preparing Macintosh Installers and 
Program Files” (page 129).

If you are creating a hybrid CD that includes a Linux partition, you also need 
to specify the location of the Linux installation files that you decompressed 
from the Linux tar file produced by the CCK tool.

3. Using a bit-compare utility such as Microsoft WinDiff, verify that the files on 
the CD exactly match the files in the \Output directory on your hard disk.

If the files don’t compare exactly, make sure you’re comparing the correct set 
of files on your hard disk with the files on the master CD. The most common 
reason bit comparisons fail is that the wrong set of files are being compared.

4. Using a virus checker program, verify that the files on the CD are virus free.

Your gold master disc is now ready for duplication.

5. Create a second gold master disc and keep it in a safe place for archive 
purposes.

6. Provide your gold master disc to a CD duplication service.

Before the duplication service completes your entire order, be sure to request 
that the duplication service sends you the first several CDs, so you can verify 
that the contents of these CDs exactly matches your gold master archive CD. 
Alternatively, you can request that the duplication service performs this step.

7. Distribute the CDs to your customers.

Depending on how you plan to distribute your CDs, you may want to create a 
printed cover that can be inserted into the CD’s plastic jewel case (the plastic case 
that contains the CD). Your duplication service may offer this service to you. 
Alternatively, programs such as Adaptec Easy CD Creator include a template for 
creating printed jewel case inserts.
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Distributing Network-Downloadable Installers or 
Binaries

To distribute Netscape 7.0 over the network:

1. On your HTTP or FTP site, create a Netscape download directory that 
corresponds to:

❍ For Windows (stub installers): the location you entered for the FTP 
directory in the CCK tool.This is the directory you’ll use to store the 
Netscape installer files.

❍ For Linux (fat installer): the location where you plan to put the Linux tar 
file produced by the CCK tool.

❍ For Mac OS X (customized binaries) and Mac OS 9 : the location where 
you plan to put the compressed Mac OS files you modified using your 
customized Windows installation files.

2. If you are preparing a Windows installer, copy the contents of the directory

installation_directory\CCKTool\Configs\my_config\Output\

into the download directory on your FTP or HTTP site. 

If you are providing a Macintosh installer (Mac OS 9) or binaries (Mac OS X) 
for network download, you also need to copy the self-extracting archive that 
you created as described in Chapter 14, “Distributing Your Installers” 
(page 137).

If you are providing a Linux tar file for network download, you need to copy 
the Linux tar file from the Output directory.

3. If you are preparing a Windows installer, put the N6Setup.exe file for your 
Windows installer one level above the download directory. For example, if the 
download directory is NS/download, put the NSSetup.exe file in the NS 
directory.

In addition to setting up the download directory, you should provide instructions 
on your web site for each type of installer available.
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End-User Instructions for Windows
Instruct your Windows users to follow these steps:

1. Create a new folder on their hard disk.

2. Download the NSSetup.exe to that new folder from the HTTP or FTP location 
provided by the ISP.

3. Double-click the NSSetup.exe to install Netscape.

4. Delete the new folder when installation is complete.

End-User Instructions for Macintosh
If you are providing a Macintosh Mac OS 9 installer for network download, 
instruct your Macintosh users to follow these steps to install Netscape:

1. Download the self-extracting archive from the HTTP or FTP location provided 
by the ISP.

2. After the file downloads and extracts itself into the Netscape Full Installer 
directory, double-click the Netscape Installer file to install Netscape. 

If you are providing a Macintosh Mac OS X binary for network download, instruct 
your Macintosh users to follow these steps to install Netscape:

1. Download the self-extracting archive from the HTTP or FTP location provided 
by the ISP.

2. After the file downloads and extracts itself, double-click the file Netscape 
Installer file to run Netscape. 

End-User Instructions for Linux
If you are providing a Linux binary for network download, instruct your Linux 
users to follow these steps:

1. Download the Linux tar file from the HTTP or FTP location provided by the 
ISP.

2. Untar the tar file.

3. Go to the directory netscape-installer.

4. Run ./netscape-installer to install Netscape.
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5. Delete the netscape-installer directory when installation is complete.
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Appendix A

Resources for ISPs

Setting up an ISP involves a range of business, financial, and technical issues. This 
appendix provides links to online sources for more detailed information. 

This appendix contains these sections:

Business Planning
Setting Up Your Servers and Internet Feed
Preparing Your Account Setup Solution
Troubleshooting and Customer Support

Business Planning
Before you begin planning the technical details of your ISP, you need to address a 
range of basic business issues, including market research, financing, and setting up 
your basic business infrastructure. At a minimum, this includes obtaining 
necessary state and local licenses, setting up office services such as phone systems 
and accounting software, domain registration, and so on. 

You should also have identified your potential customers, created a viable 
marketing and business plan, worked out a detailed budget, identified sources of 
technical assistance (your own employees or external services), and performed all 
the other tasks required to set up a successful business. The ISP industry is mature 
and highly competitive; you will not succeed unless you do your homework.

If you decide you want to contract with external services for help with software 
preparation and distribution, see Netscape To Go for information on assembling an 
appropriate software and distribution solution:

http:www.netscapetogo.com
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For background information on planning and setting up an ISP business, see the 
following:

• http://www.isp-planet.com/

• Can I start an ISP with $15000?
http://www.isp-planet.com/business/2001/15k_bol.html

• Newbie’s Guide to Starting an ISP
http://www.isp-planet.com/business/start_an_isp-a.html

• ISPPlanet Guide to Building an ISP
http://www.isp-planet.com/resources/isp_guide/index.html

• How We Started Our Own ISP
http://www.techtv.com/screensavers/showtell/story/

0,23008,2196566,00.html

Setting Up Your Servers and Internet Feed
To provide Internet access, an ISP needs to sign up with a regional or national 
backbone provider and set up a local loop—that is, a physical connection between 
your location and the provider. In general, it’s preferable to set up a 24 channel T1 
or equivalent circuit for your first access switch. 

An ISP also needs servers to handle its primary functions, including DNS, mail, 
Web servers (both HTTP and HTTPS), authentication, and news. Theoretically, you 
can do all this on just one machine, but at least four separate dedicated PCs is 
usually considered the minimum requirement. 

One of the most basic decisions you must make is whether to own your own server 
facilities, rent them, or use a hybrid solution that permits users to connect to your 
service through other service providers as well as your own.

For more information on these decisions and other aspects of setting up your 
servers and Internet feed, see the following:

• Make Your ISP Facilities-Based or Non? 
(http://www.isp-planet.com/business/052099facilities-pt1.html) in 
ISPPlanet Guide to Building an ISP.

• Newbie’s Guide to Starting an ISP
http://www.isp-planet.com/business/start_an_isp-a.html
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• What Do I Need for My WebSite?
http://www.cultureandrecreation.gov.au/resources/guides/g8/s1.ht

m

Preparing Your Account Setup Solution
When a customer signs up with your ISP service, you need to provide an Account 
Setup solution as well as a customized version of Netscape 7.0. An Account Setup 
solution helps users create ISP accounts and configures both system software and 
Netscape 7.0 to enable Internet access. Configuration includes:

• System software (such as modem drivers, dialers, network protocol stack)

• Internet access information (such as dialup access numbers, network settings, 
server settings)

• End-user-specific settings (such as ISP account name, user email address) for 
Netscape

An Account Setup solution can take one of two forms:

• Online Account Setup prompts for customer information to create an ISP 
account (for example, contact information, preferred email account name, and 
payment plan). Account Setup then connects to an ISP account setup server 
and uploads the new account request. After processing the request, the server 
downloads the corresponding configuration to Account Setup, which uses it to 
automatically configure Internet access and other settings for the end user.

• Manual Account Setup requires the end user to enter the appropriate 
configuration information manually and initiate the connection process. 
Therefore, you need to provide step-by-step instructions for each platform that 
you support. For example, see the instructions outlined in Appendix B, 
“Manual Account Setup” (page 149).

Troubleshooting and Customer Support
After you’ve set up your ISP business and your customers have set up your 
accounts, you need to provide ongoing troubleshooting and customer support. For 
information on these and other topics related to browser distribution and support, 
see the links and other resources available from the Netscape Browser Distribution 
Program:

http://home.netscape.com/bisdev/distribution/index.html?cp=ncpc 
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Appendix B

Manual Account Setup

Once your customers have installed Netscape from a CD or over the network, they 
need further instructions for setting up and using their ISP account.

This appendix summarizes the minimum information you need to give your 
dial-up customers as part of their manual Account Setup instructions for Windows 
NT. You can use it as a starting point in developing your own detailed instructions 
for use by your customers on various operating systems.

This appendix contains these sections:

Preliminaries
Set Up the Dialer
Create a Modem Location
Set Up TCP/IP
Log On and Start Netscape

Preliminaries
Before installing Netscape and performing the setup tasks described in this 
appendix, a customer typically contacts the ISP, provides billing information, and 
fulfills any other requirements for setting up an account, such as creating a new 
user name and password.

In addition to installation instructions and other preliminary information, the ISP 
must provide a complete set of instructions describing what configuration tasks the 
user needs to perform after installing the Netscape software, such as configuring 
the system and browser software, connecting with the ISP, and logging on. 

Many ISPs prefer to automate some or all of these tasks using special software. 
For information about custom distribution solutions, see

http://www.netscape.togo.com
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Set Up the Dialer
Exact dialer setup instructions vary depending on the dialer software you want 
your customers to use and the modems they have installed. 

For example, users can follow these instructions to set up the Dial-Up Networking 
utility provided with Windows NT:

1. Open the My Computer icon on the Windows NT desktop and double-click the 
Dial-Up Networking icon.

2. Click New.

The New Phonebook Entry Wizard appears. Fill in the requested information, 
clicking Next after you complete each screen. The titles of the Wizard screens 
are given in boldface in the instructions that follow.

3. New Phonebook Entry Wizard: 

Name the new phonebook entry:

(Example: Mach Networks)__________________________________________

4. Server:

Select the following checkboxes:

_____I am calling the Internet.

_____Send my plain text password if that’s the only way to connect.

_____The non-NT server I am calling expects me to type login information after 
connecting, or to know TCP/IP addresses before dialing.

5. Phone Number: __________________________________________

When you fill in the dial-in phone number and click Next, you see the last New 
Phonebook Entry Wizards screen.

6. Click Finish in the last Wizard screen.

7. Click Close in the main Dial-Up Networking screen.
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Create a Modem Location
Exact modem setup instructions vary depending on the modem your customer is 
using. The instructions that follow assume that the user is has previously installed 
and configured a modem. For information on these tasks, see Windows NT Help.

Your users must have an appropriate Location set up for their modems to work 
correctly with your service. For example, they can follow these steps to set up 
appropriate Location information for use with an installed modem:

1. Open the Start menu and choose Control Panel.

2. Double-click the Modem control panel.

3. Click Dialing Properties.

The Dialing Properties dialog box appears.

4. Click New.

A New Location appears in the field labeled “I am dialing from:”

5. Type the name of your location (Example: San Francisco).

6. Select the appropriate region from the drop-down list labeled “I am in this 
country/region:” (Example: United States of America).

7. Fill in all relevant information about your phone line, including area code, 
access to an outside line, long distance calls, call waiting, tone versus pulse 
dial, and calling card information.

8. Click OK.
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Set Up TCP/IP
On Windows, you can access TCP settings through the Network control panel. To 
configure these settings:

1. Click Start, then Settings, then Control Panel, and double-click the Network 
control panel. 

2. Click the Protocols tab.

3. Double-click TCP/IP Protocol.

4. In the IP Address tab, select the adapter for the modem you will be using and 
select one of these options:

_____Obtain an IP address from a DHCP server. This option is typically used 
with dial-up connections.

_____Specify an IP address. If you are assigning an IP address to the user, 
select this option and provide the following information:

IP address (Example: 000.000.000.000)___________________________________

Subnet mask (Example: 000.000.000.000)_________________________________

Default gateway (Example: 000.000.000.000)______________________________
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5. Click the DNS tab and enter the following information:

Host name (Example: mach-networks.net)_______________________________

Domain (Example: www.mach-networks.net)____________________________

DNS Service Search order
Click Add to add each of these DNS Service Search Order entries:

(Example: 
000.000.000.000)____________________________________________

(Example: 
000.000.000.000)_____________________________________________

(Example: 000.000.000.000) __________________________________________

Domain Suffix Search Order:

Click Add to add each of these DNS Suffix Search Order entries:

(Example: mach-networks.net)_________________________________

(Example: mach-networks.net-1)_______________________________

(Example: 
mach-networks.net-2)_______________________________________

6. Click the WINS Address tab and enter the following information:

Primary WINS Server (Example: 000.000.000.000)________________________

Secondary WINS Server (Example: 000.000.000.000)______________________

____Enable DNS for Windows Resolution

____Enable LMHOSTS Lookup 

7. Click OK, then click OK again. When asked if you want to restart your 
computer, click Yes.
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Log On and Start Netscape
Once your users have entered the settings described in the preceding sections, they 
are ready to dial up your service, log on, and start Netscape. 

Here are some sample instructions that use the Dial-Up Networking utility 
provided with Windows NT:

1. Open the My Computer icon on the Windows NT desktop and double-click the 
Dial-Up Networking icon.

2. Select the ISP phonebook entry that you set up earlier. (Instructions for 
creating this entry are provided in “Set Up the Dialer” on page 150.)

(Example: Mach Networks)__________________________________________

3. Click Location.

The Location Settings dialog box appears.

4. Select the location you set up earlier. (Instructions for creating this entry are 
provided in “Create a Modem Location” on page 151.) 

5. Fill in any necessary prefix or suffix information as appropriate for your phone 
line.

6. Click OK.

7. Click Dial.

The Connect dialog box appears.

8. Enter the following information:

User name (Example: joe@mach-networks.net)___________________________

Password (Example: joe@mach-networks.net)___________________________

Domain: (Example: mach-networks)_____________________________________

____Save password

9. Click OK.

After your users have logged on successfully, they follow the steps below to start 
using your customized version of Netscape.
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IMPORTANT NOTE: If you have customized Mail, you may to disable Netscape 
activation after you create your custom Netscape installer. If you don’t disable 
Netscape activation, you will need to provide additional instructions for your 
users. For details, see “Netscape Activation Considerations for Mail and News” 
(page 78). 

These instructions assume that Netscape activation has been disabled and that the 
user does not have a preexisting Netscape profile.

1. Open the Start menu and choose Programs, then 

(Example: Netscape 7.0 by Mach Networks)_____________________________

then Netscape.

Note: If you have customized the Welcome screen—that is, the URL that the 
browser window displays when a new user starts Netscape for the first time— 
you can use it to convey additional account setup details or other information 
you want your new users to read.

2. Open the Tasks menu and choose Mail & Newsgroups.

The first screen of the Account Wizard appears.

3. Select the following radio button and click Next:

(Example: Mach NetworksNews Account)______________________________

4. Enter the following information and click Next:

Your Name (Example: John Chapman)___________________________________

Email Address (Example: chapman@mach-networks.net)___________________

5. Verify that the information summarized by the system is correct, and click 
Finish.

Note: If you customize the mail server information with the CCK tool, the user 
doesn’t have to enter it. If you have not customized server information, the 
user must specify it in an additional screen at this point.

You should provide similar instructions for setting up a newsgroups account.
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Appendix C

Netscape Profile Locations by
Platform

By default, Netscape profiles are stored in different places on different platforms. 
Users may also choose a directory or folder in which to store their profile data.

The directories shown in Table C-1 on the next page are the defaults for profile and 
registry storage. Paths to the Mozilla directory vary among platforms. The 
mozilla directory always contains the following:

• The profile registry (name varies among platforms)

• A directory called Profiles 

The Profiles directory contains one or more directories whose names correspond to 
Netscape profiles (shown as profile_name in Table C-1). Each of these directories 
includes another directory whose name is composed of random numbers and 
letters (shown as salted_name in Table C-1).

Important: The directory Application Data may be hidden on some Windows 
platforms (such as Windows 2000). If this is the case, the user should follow these 
steps to see it:

1. Open the View menu for the Mozilla directory and choose Options.

2. Click the View tab.

3. Under Hidden Options, click “Show all files”.
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Table C-1 Locations of Netscape profile information on different platforms

Platform Profile directory

Windows ME C:\Windows\Application 
Data\Mozilla\Profiles\profile_name\salted_name 

Windows 2000/
Windows XP

C:\Documents and Settings\user_name\Application 
Data\Mozilla\Profiles\profile_name\salted_name

Windows NT C:\Winnt\Profiles\user_name\Application 
Data\Mozilla\Profiles\profile_name\salted_name 

Windows 95/
Windows 98

If password protection is disabled:

C:\Windows\Applicationë 
Data\Data\Mozilla\Profiles\profile_name\salted_name

If password protection is enabled:

C:\Windows\Profiles\user_name\Application 
Data\Mozilla\Profiles\profile_name\salted_name

Macintosh OS 
8.6-9.1

boot_disk:Documents:Mozilla: 
Profiles\profile_name\salted_name

Registry:

boot_disk:System Folder:Preferences:Mozilla Registry

Macintosh OS X boot_disk:Users:user_name:Library:Mozilla 

Registry:

boot_disk:Users:username:Library:Preferences:
MozillaRegistry

Linux Enter

'echo $HOME' 

to find where $HOME is pointing to. The registry and profiles are in 
$HOME/.mozilla)


